PhotoGrav
Version 2.11
User Guide

September 21, 2000
IMPORTANT !!

Display Settings

Your display should be set for 24- or 32-bit True Color and the screen resolution (screen "size") should be no more than 1024 x 768. These properties can be set in the "Display Properties" dialog box which can be initiated by right clicking on your display's wallpaper, then left clicking "Properties" in the resulting menu, and finally clicking the "Settings" tab in the dialog box.

PhotoGraV Installation

The instructions for installing from your CD-R are on page 1-4 of the PhotoGraV User Guide and are repeated below. Be sure to read Section 1.2 (page 1-2) of the User Guide before installing the program!

1. Start Windows if you have not already done so.
2. Insert the CD into your CD-ROM drive.
3. If Autorun is enabled on your system, installation will start automatically. Otherwise, click Start, then Run and enter X:\setup.exe where X is your CD-ROM drive.
4. Click OK.
5. Follow the instructions on the screen.

Note: During installation you will be asked to enter your PhotoGraV serial number. It is located on page i (first page) of the User Guide and on your invoice.

Supplemental "Named Parameter Sets"

We have included supplemental "Named Parameter Sets" which are described in one of the letters accompanying the User Guide. The Named Parameter Sets are in a folder named "New Parameter Sets" on the CD-ROM. Read the letter enclosed in the User Guide for a description of how to use the supplemental "Named Parameter Sets".
Additional *PhotoGraV* Samples

There are some additional samples included on the *PhotoGraV* CD-ROM. The samples include:

1) Four grayscale ".BMP" images which can be used as input to *PhotoGraV*
2) "Engraved Images" (binary images) produced by *PhotoGraV* using the supplied input images and processing each input image for one of four engraving materials
3) The named parameter sets used to create each of the binary images
4) Coreldraw files for actually engraving the processed images

These samples are contained in the directory `\Samples` on the CD-ROM (the other directories on the CD-ROM are named `\DISK1` ... `\DISK5` and contain the *PhotoGraV* program files).

The directory `\Samples` contains two sub-directories: `\250dpi` and `\300dpi`. If you have a ULS laser engraver then you should use the samples contained in the `\250dpi` subdirectory. If you have an Epilog or LMI laser engraver, then you should use the `\300dpi` subdirectory. If you have a laser engraver from some other manufacturer, then you should use the directory that corresponds to the resolution of that engraver, e.g., if your engraver has resolutions of 150, 300, 400, 600, and 1200 dpi, then use the samples in the `\300dpi` subdirectory. If your engraver has resolutions of 125, 250, 333, 500, and 1000 dpi, then use the samples in the `\250dpi` subdirectory.

Within each of the two subdirectories `\250dpi` and `\300dpi` are four subdirectories corresponding to four engraving materials and named: `\Acrylic`, `\Aluminum`, `\CherryWd`, and `\PPLpIStc`. These four subdirectories correspond to engraving materials: Clear (cell-cast) acrylic, anodized aluminum, cherry wood, and micro-capped IPL plastic. There are four files in each of the subdirectories. The file named `xxxxx.BMP` (where `xxxxx` is the name of the subdirectory that contains the file) is an 8-bit grayscale image that can be used as input to *PhotoGraV*. The file named `Binary.BMP` is the "Engraved Image" produced by *PhotoGraV*, i.e., it is the processed image that is ready for engraving. The file named `xxxxx.prm` is the named parameter set that was used to process the image in *PhotoGraV*. Finally, the file named `xxxxx.cdr` is a CorelDraw file that contains the processed image with some added text and which is ready to be sent to your engraver. This Coreldraw file also contains some additional information about the Power, Speed, and dpi settings that were used to actually engrave the samples.

The samples can be used in several ways. You can open the images (xxxxx.BMP) in *PhotoGraV*, use the "Load Params" button to select the corresponding named parameter set (xxxxx.prm), and then click "Auto Process" to process the image. The files can be used directly from the CD-ROM and need not be loaded onto your hard disk. Going through this process should give you a good idea of what good input images should look like, what parameters are good for the four sample materials, and what the processed (binary) image should look like. Or you can merely import the already-processed images (Binary.bmp) into Coreldraw and engrave them immediately to get an idea of how well photos engrave on the four sample materials. Or you can use the sample Coreldraw files to do the same thing. The Coreldraw files also contain the sizes of the engraving materials that should be used for each of the sample materials.
PhotoGraV User Guide
Summary of Important Points

There are three basic steps to engrave a photograph:

1. Scan the photo and save it on disk as a grayscale (8-bit) "BMP" file.
2. Process that file in PhotoGraV and save the "Engraved Image" as a file on disk.
3. Import that file into CorelDraw, or equivalent, and engrave it in the usual fashion.

There are some important rules to keep in mind in accomplishing the above three steps:

Step 1: Scan the Photo

A. If you are using an Epilog or LMI laser engraver, then the image which is saved on disk just prior to PhotoGraV processing should have a dpi (dots per inch) of either 300 or 600. If the laser engraver is a ULS, the image dpi should be 250 or 500. Generally, 250 or 300 dpi is adequate resolution for the PhotoGraV input image.

B. The image should be the right size, in inches, for engraving before it is processed in PhotoGraV. You can use Adobe PhotoShop, Corel Photopaint, or some other appropriate image processing program to set the size and dpi of the image before storing it on disk, i.e., the photo can be scanned at some convenient size and resolution and then modified in one of these programs.

C. The image to be processed by PhotoGraV must be a grayscale (8-bit) "BMP" image file. If you are dealing with a color photo, then you can scan it in color if you wish and use one of the image processing programs to convert it to a grayscale (8-bit) image just before saving it on disk.

Step 2: Process the file in PhotoGraV

A. Open the image in PhotoGraV. PhotoGraV will only open 8-bit grayscale images.

B. Select the material on which you are going to engrave the photo. This can be done by clicking the "Select Material" button and then choosing a material from the resulting list or by clicking the "Load Params" button and selecting a named parameter set. There are a number of named parameter sets that are furnished on the installation CD-ROM described in one of the cover letters accompanying the PhotoGraV program. These parameter sets are equivalent to selecting a material but have improved parameters compared to the original materials. It is advisable to copy these parameter sets to a subdirectory on your hard disk and use them as described in the referenced cover letter.

C. Click the "Auto Process" button. PhotoGraV processes the image and displays three images on the resulting screen although only one image is initially visible. You can view the three images in sequence by clicking the "Cycle Images" button on the toolbar in the upper part of the screen. The three images are:

1) The "Original Image": This is just the input image.
2) The "Simulation Image": This is an attempt to simulate what your engraving will look like.
3) The "Engraved Image": This is the binary image (black and white dots) that should be saved on your disk for subsequent import to CorelDraw or equivalent.
Step 3. Import the "Engraved Image" file into Coreldraw and engrave it.

A. The image file that is imported into Coreldraw should not be resized nor rotated once it is in Coreldraw. You can, however, position the image file wherever you want on the page, flip the image file left-to-right or top-to-bottom, and add text anywhere on the page.

B. The engraving resolution, i.e., that resolution or dpi that is specified in the Print driver, should be equal to the dpi of the imported image file or a factor of two larger. That is:

1) For Epilog and LMI engravers, you should usually engrave most woods at 300 dpi and most other materials at 600 dpi.
2) For ULS engravers, you should usually engrave most woods at 250 dpi and most other materials at 500 dpi.

With practice and experience, you will find that you can often achieve almost identical results for some materials by engraving at the lower (250 or 300) resolution although you have to adjust the power and speed appropriately as specified in one of the "Rules of Thumb" occurring later in this Guide.

Engraving on Wood

Engraving on most woods presents a special problem in that areas that are very dark on the photo produce a dense concentration of LASER-ON dots in those areas. The resulting concentration of heat in the area causes the dots to merge, resolution is lost, and the area appears muddy.

Therefore, if you are engraving a photo onto wood such as cherry, Red Alder, maple, aromatic red cedar, etc., scan the image and use Adobe PhotoShop or Corel Photopaint to set the size and dpi as described in a preceding paragraph (Step 1: Scan the Photo) and to make the image "look good". Convert the image to a grayscale image if not scanned as a grayscale. Then, use the function "Image/Adjust/Tone Curve" in Photopaint or "Image/Adjust/Curves" in PhotoShop to remap the gray shades as pictured below (the dialog box is from Photopaint; the one from PhotoShop is similar):
Using this function with the curve as pictured makes darker areas lighter but keeps lighter areas at approximately the same brightness. This will make the image look somewhat "washed out" (low contrast) but has the desirable effect of reducing "overburn" in dark areas of the photo when engraved on wood. This preprocessing is not necessary for other materials. Save the image on disk as a grayscale ".BMP" image.

Open the grayscale image in PhotoGraV, select the engraving material or load a parameter set, and then click the "Interactive Process" button. On the resulting screen, click the "Adjust Gray" button and, in the dialog box that appears in the bottom center of the screen, move the left slider all the way to the left (so Black is 0) and move the right slider all the way to the right (so White is 255). See Section 3.2.2.1 on page 3-10 of the PhotoGraV User Guide for more details on what the "Adjust Gray" function does. Then click the "Proceed" button to process and to inspect the results.

If engraving photos on wood, it is often a good idea to increase the contrast by using a "fill" on the engraved areas. One such technique is described in the PhotoGraV User Guide as point 1 in Appendix 2, starting on page A2-1.

Rules of Thumb

A handy rule of thumb formula is:

Degree of Burn = Power/Speed

where Power and Speed are measured in % of max, i.e., the settings on the engraver panel or in the engraving printer driver.

Thus, halving the speed is roughly equivalent to doubling the power. That is, if you engrave something at a given power and speed you could get a much darker engraving by either doubling the power or halving the speed. Or, if you engrave something at a given power and speed, you should get roughly the same engraving result if you engrave at half the power and half the speed (or double both the power and speed). Another example is that if you engrave something at a Power, P, and a speed, S, then you should get roughly the same engraving result if you engrave at Power = 1.2 P and Speed = 1.2 S.

Another rule of thumb is that if you engrave something at 300 dpi (250 dpi for ULS) and then want to engrave it at 600 dpi (500 dpi for ULS) and want to get roughly the same degree of burn, then you should reduce the power by a factor of two (or increase the speed by a factor of two - see point 6 above). Conversely, if you engrave something at 600 dpi (500 dpi for ULS) and then want to engrave it at 300 dpi (250 dpi for ULS), then you should increase the Power setting by factor of two (or decrease the speed by a factor of two - see point 6 above).

This rule of thumb works reasonably well for materials that truly burn or vaporize such as wood, acrylics, plastics, etc. It does not apply to materials such as black marble for which the laser is merely destroying the reflectivity of the material's surface. For such materials, increasing the dpi has much less effect than for materials that burn or vaporize.

See Section 2.3 of the PhotoGraV User Guide (page 2-5) for a more complete review of important information.
Graphics Card Difficulties?

A small number of graphics cards, especially ATI cards on Dell PCs, have been released with video drivers that do not properly handle some of their hardware acceleration features. If PhotoGraV does not properly display the input image, or exhibits any other abnormal behavior, then try the following procedure before calling for Technical Support:

1. Click Start/Settings/Control Panel and then double click the "Display" icon in the Control Panel dialog box.
2. In the resulting "Display Properties" dialog box, click the "Settings" tab at the top.
3. In the resulting screen, first ensure that the "Colors" setting (lower left) is set to "True Color", either 24 or 32 bits. If not, change it so it is "True Color".
4. Next, click the "Advanced" button in the lower right.
5. Click the "Performance" tab ("Troubleshoot" in WinXP) at the top of the resulting screen.
6. In the resulting dialog box, move the "Hardware Acceleration" slider to the left of "Full" (one place to the right of "None").
7. Then click "OK" and then close the "Display Properties" dialog box.
8. Restart your computer when prompted to do so.

Changing the "Hardware Acceleration" slider should have no discernible effect on the performance of your PC. It is used mostly for 3D games.
Copyright Information

PhotoGrav Version 2.11 User Guide

© 1997 Schrock’s Computer Works. All rights reserved.

This document is for information purposes only. Schrock’s Computer Works makes no warranties, expressed or implied.

Other brand and product names are trademarks or registered trademarks of the respective holders. Microsoft is a registered trademark and Windows is a registered trademark of the Microsoft Corporation.

The characteristics of the laser engravers modeled by PhotoGrav were taken from published specifications and review articles. The use of these characteristics does not represent an endorsement of PhotoGrav by the respective laser engraver manufacturers nor a commitment to the specifications on the part of the manufacturers.

Information in this document is subject to change without notice and does not represent a commitment on the part of Schrock’s Computer Works. The software described in this document is furnished under a license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license or nondisclosure agreement. No part of this manual may be reproduced or retransmitted in any form or by any means, electronically or mechanically, including photocopying, recording, or information recording and retrieval systems, for any purpose other than the purchaser’s personal use, without the express written permission of Schrock’s Computer Works.
# Table of Contents

Introduction ......................................................... v

Chapter 1: Getting Started ........................................ 1-1

1.0 Using this Document ........................................... 1-1
1.1 System Requirements .......................................... 1-1
1.2 Preliminaries .................................................. 1-2
1.3 Installation ................................................... 1-4
1.4 Quick Start Scenario .......................................... 1-5
1.5 Additional Tutorial Scenarios ............................... 1-7

Chapter 2: Operational Overview ................................. 2-1

2.0 Introduction ................................................... 2-1
2.1 Flow of Events ................................................ 2-1
2.2 Basic PhotoGrav Concepts ................................... 2-3
2.3 Important PhotoGrav Information ......................... 2-5

Chapter 3: Primary Windows ...................................... 3-1

3.0 Introduction ................................................... 3-1
3.1 Input Selection Window ...................................... 3-1
3.2 Interactive Process Window ............................... 3-7
3.3 Engraving Results Window ................................. 3-21
3.4 Text/Resize Window .......................................... 3-27

Chapter 4: Support Windows ...................................... 4-1

4.0 Introduction ................................................... 4-1
4.1 Preferences Window .......................................... 4-3
4.2 Modify Material Window ..................................... 4-7
4.3 DPI Specification Window .................................. 4-12
4.4 Info Report Window .......................................... 4-13
4.5 Print Window ................................................ 4-15

Chapter 5: Using Help .............................................. 5-1

5.0 Introduction ................................................... 5-1
5.1 Context Sensitive Help ....................................... 5-1
Introduction

PhotoGrav has been designed specifically for Laser Engravers. The objective of the program is to efficiently process digitized photographs so they can be engraved on a variety of common engraving materials with a high degree of confidence that the engraved photographs will be acceptable products.

Traditionally, the engraving of photographs has been difficult and has been a hit or miss endeavor resulting in many discarded objects. The process has been so difficult and costly, in fact, that many Engraving shops simply do not offer engraved photographs as one of their standard products. PhotoGrav has been designed to address this problem and does so in three ways:

1. It provides a set of powerful tools that have been found effective in processing photos for engraving.
2. It provides an automated application of these tools to the subject photo.
3. It provides a simulation of the engraving process for many common materials so the “engraved product” can be inspected before it is actually engraved.

Currently, PhotoGrav simulates more than 20 engraving materials including: cherry and walnut wood; clear and black-painted acrylic; black laser brass and anodized aluminum; a variety of generic leather materials; and many plastics with either a white or black core and with a variety of caps including brushed gold and most solid colors. PhotoGrav’s processing functions have been tuned and optimized for each of these materials and the appropriate optimized parameters are automatically loaded whenever a new material is selected. Further, PhotoGrav automatically compensates for the engraving peculiarities of each material in the process of creating the “engraver-ready” processed image. For example, photos to be engraved on clear acrylic are automatically mirror-imaged and produced at a “negative” polarity. Of course, you can override these automatic features at any time to produce special effects if so desired.

The PhotoGrav process is very simple: (1) You select the digitized image that you want to engrave, (2) You select the engraving material, and (3) You choose the Auto Processing option within PhotoGrav. The next thing you see on your computer monitor, usually within a minute or two, is a simulation of what the image will look like when it is actually engraved on the material you have chosen. You can then save the image on disk and use your favorite image processing program, e.g., CorelDraw, to send the image to the engraver.

Of course, the simulated engraving might not look quite like you wanted so instead of saving the image on disk you can reprocess the image by “tweaking” the parameters that PhotoGrav had
originally chosen for the image. Most of the time, however, the automated processing in PhotoGrav is so good that you won’t be able to improve on the automated rendition no matter how long you tweak.

Using an energy and lens model, PhotoGrav has been calibrated for many laser engravers from the major manufacturers. However, PhotoGrav goes one step further in that it provides a “Named Parameter Set” capability that allows you to customize and automate PhotoGrav’s processing for your particular machine and for the particular materials that you use.

As a final note, we would like to point out that PhotoGrav has NOT been designed in a vacuum by computer scientists who have merely a passing acquaintance with a laser engraver. Rather, it has been designed by a team of engravers, physicists, and computer scientists who have pooled their experience, knowledge, and talents to result in a truly unique and remarkable product for the laser engraving community. This team wishes you all possible success in using PhotoGrav and welcomes your comments for improvements to future PhotoGrav versions.
Chapter 1
Getting Started

1.0 Using this Document

This document has two objectives: (1) To acquaint you with PhotoGrav so you can be productively using the program as rapidly as possible and (2) To serve as a complete reference source for all of PhotoGrav's components and operational characteristics.

To satisfy the first objective, chapters 1 and 2 have been written to present essential information and concepts in as concise a manner as possible. Chapter 1 provides the information necessary to install PhotoGrav and to begin using it almost immediately. A series of logically-connected scenarios, with furnished imagery, provides immediate hands-on experience and should give you a good idea of PhotoGrav's basic operational characteristics. Chapter 2 presents an overview of the flow of events within PhotoGrav, discusses some basic PhotoGrav concepts and rationale, and presents a summary of important information that you should know about the program.

The remainder of the chapters, especially chapters 3 and 4, provides a detailed reference source for all of PhotoGrav's features. Chapters 3 and 4 present detailed descriptions of PhotoGrav's Primary and Support windows, respectively. Chapter 5 describes how to use the program's Help capability and Chapter 6 explains what to do if you have any difficulties in using PhotoGrav. The Appendices present supplemental information in specialized areas.

At a minimum, after installing the program, you should read Sec. 1.4 and step through the scenario presented in that section. You should also definitely read Sec. 2.3, Important PhotoGrav Information. Preferably, to really understand and fully use PhotoGrav's extensive capabilities, you should read Chapters 1 and 2 in their entirety.

1.1 System Requirements

To use PhotoGrav, you need the following hardware and software:
Hardware

Minimum Configuration

- Intel 80386-based PC
- 8 megabytes (MB) of RAM
- Hard disk with at least 20 MB of free space (see Notes below)
- Mouse or other compatible pointing device
- 16-bit, 24-bit, or 32-bit display adapter at 640 X 480 or larger

Recommended Configuration

- Pentium processor
- At least 16 MB of RAM
- Hard disk with 50 MB of free space (see Notes below)
- Mouse pointing device
- 24-bit or 32-bit display adapter at 800 X 600 or 1024 X 768

Software

- Windows 98, Win2K, WinME, or WinXP

Notes on Hardware Requirements:

PhotoGrav itself requires less than 5.5 MB of hard disk space for program and data files. However, several temporary disk files are created during PhotoGrav execution on the disk where you installed PhotoGrav. These files are used as temporary storage for some of the images which are generated during execution. The sizes of these temporary files are proportional to the size of the digitized photo which is to be engraved and thus the required hard disk space is a "soft" number which depends on your operational scenario. All PhotoGrav temporary files are deleted when PhotoGrav terminates execution.

1.2 Preliminaries

PhotoGrav requires that your computer monitor be set up to display a pixel depth (sometimes called color palette) of at least 16 bits per pixel but 24 or 32 bits per pixel is strongly recommended. It is also desirable, but not necessary, that the display resolution (desktop area) be set to at least 800 x 600 or, if possible, to 1024 x 768.
To check if your monitor settings satisfy these requirements, or to change the settings to meet the requirements, perform the following steps:

1. Double click the **My Computer** icon.
2. In the resulting dialog box, double click the **Control Panel** icon.
3. In the resulting dialog box, double click the **Display** icon.
4. In the **Display Properties** dialog box, select the **Settings** tab.
5. In the resulting dialog box:
   a. For the **Color Palette***, choose:
      - High Color (16-bit) or preferably
      - True Color (24-bit) or True Color (32-bit)
   b. For the **Desktop area***, move the slider to:
      - 1024 x 768 pixels, if available, or
      - 800 x 600 pixels, if available, or
      - 640 x 480 pixels.
   c. If the Desktop area is 800 x 600, then:
      - Select “Small Fonts” in the **Font size** dropdown list.
6. Click **OK** to leave the **Display Properties** dialog box.

*The **Color Palette** and **Desktop area** settings are interrelated and some of the palette settings are sometimes not available for some of the desktop area settings depending on your computer’s display adapter card. A good general rule is to set the desktop area to the largest size possible, up to 1024 x 768, for which one can still set the palette setting to at least 16 bits.

Depending on your selections, Windows might inform you that you have to restart your computer at this time. If so instructed, restart the computer or the new settings will not be activated.
1. Start Windows if you have not already done so.

2. Insert the CD into your CD-ROM drive.

3. If Autorun is enabled on your system, installation will start automatically. Otherwise, click Start, then Run and enter X:\setup.exe where X is your CD-ROM drive.

4. Click OK.

5. Follow the instructions on the screen.

   *Note:* During installation you will be asked to enter your PhotoGrav serial number. It is located on page i (first page) of this document and on your invoice.

The installation process will create an icon for PhotoGrav and will either add that icon to an existing Program Group or will create a new Program Group if you so choose. The installation process also adds the icon and the “Program Group” to the Program list on the Start menu. In all cases, the installation process will also create an Uninstall icon that allows you to easily remove PhotoGrav from your system. Use the “Add/Remove Programs” capability in the Control Panel to uninstall the program. If you have any difficulties installing PhotoGrav, check Sec. 6.1.5.1.
1.4 Quick Start Scenario

This section provides a "Quick Start" to using PhotoGrav by presenting a simple, but typical, engraving scenario. It introduces PhotoGrav's major features and controls and how they are used within the context of an actual engraving scenario. To successfully use this section you should have a basic understanding of Windows features and techniques. If you're anxious to try PhotoGrav and you don't like to read, then this section is for you. However, even if you consider yourself a PhotoGrav expert after completing this section, it is highly recommended that you step through the additional scenarios in Section 1.5 and then read Chapter 2 for a more complete understanding of how PhotoGrav works.

There are several definitions that one should have firmly in mind before tackling the Quick Start scenario. These definitions are listed below and can also be found in the PhotoGrav User Guide Glossary:

- **Original Image**: The image, in 8-bit grayscale .bmp format, that is the input image to PhotoGrav. This image is the digitized photograph that you want to engrave.

- **Engraved Image**: This is the processed image that PhotoGrav produces that should be sent to your laser engraver. This image is a binary image (black & white) in .bmp format.

- **Simulation Image**: This is a simulation, produced by PhotoGrav, of what the engraved image will look like when engraved on the selected engraving material. This image is a 24-bit, true color image in .bmp format. This image is useful for customer proofs and for reference BUT is NOT the image to be sent to the laser engraver.

**Scenario 1: Engrave a man's photograph on cherry wood.**

It is assumed that the man's photograph has been previously digitized and stored as a grayscale image (in .bmp format) on disk. This scenario will use the image "Image250.bmp" which has been furnished with PhotoGrav. This image should reside in the directory C:\PGDIRECT\SAMPLES where C:\PGDIRECT is the directory which you chose as the PhotoGrav root directory during the installation process.

*Note*: The image "Image250.bmp" has a dpi of 250. In general, the ratio of engraver dpi to image dpi should be an integer factor. So if your engraver has dpi's like 150, 300, 600, . . . , then in the following scenario you should use the image "Image300.dpi" which has a dpi of 300.
1. Start PhotoGrav by double clicking its icon (looks like a twirled star) or by choosing it from the Start menu. The opening screen appears.

2. Click anywhere at any time on the opening screen to continue with PhotoGrav execution which always begins in the Input Selection Window.

3. However, the very first time you run PhotoGrav, a “Welcome to PhotoGrav” Window is automatically displayed. In that window, select your engraver type by clicking one of the option buttons and enter your laser’s maximum power in watts. Then click OK to close the window.

4. Click Open Image and use the standard Windows dialog box to choose the image “Image250.bmp” which resides in the \SAMPLES subdirectory of the directory in which you installed PhotoGrav. The image should be displayed.

5. Click Select Material. (A list of engraving materials appears).

6. Scroll down the list and select “Cherry with light vertical grain” and click OK. (The list disappears and the image reappears).

7. Click Auto Process. (The Engraving Results Window appears and status messages inform you of PhotoGrav’s progress).

8. When processing is complete, a simulation of the engraving is displayed in the Engraving Results Window.

9. Click on the File menu. At this point, if you wished to save the engraved image to disk in order to later send it to your engraver, you would select the “Save Engraved Image” item in the dropdown menu that appears. A standard Windows dialog box would then appear on which you could specify the file name of the engraved (binary) image in the usual manner.

10. That’s all there is to it! You have created an image, the engraved image, which is ready to be sent to your laser engraver.

    At this point, either continue with scenario 2 (in Section 1.5) or click Exit to exit the PhotoGrav program.

Scenario 1 Notes:
1.5 Additional Tutorial Scenarios

This section presents five additional scenarios which further illustrate PhotoGrav’s features. Each scenario is a logical follow-on to Scenario 1 presented in the preceding section.

**Scenario 2: Compare the original, engraved, & simulated images.**

This scenario will demonstrate how easy it is to evaluate the engraved (binary) image by comparing it and the simulated engraving to the original (input) image. The scenario will also demonstrate some of PhotoGrav’s supporting features.

1. If you are continuing here from Scenario 1, then go to the next step. Otherwise, repeat the first eight steps of Scenario 1.
2. Click on the blue “?” button near the right-top of the Engraving Results window. (The cursor becomes a “?”).
3. Click on the Cycle Images button with the “?” cursor. (A text box appears that describes the function of the Cycle Images button).
4. Read the description of what the Cycle Images button does and then click the text box to make it disappear. (This context-sensitive help is available for practically all PhotoGrav controls).
5. Left click on the Cycle Images button. (The original, engraved, and simulation images appear in succession each time you click the button. They appear in reverse order if you use the right mouse button to click).
6. Left click at a position between the man’s eyes on whichever image is displayed. The image will be magnified. Left click again at approximately the same point. The image will be enlarged more. (Note the scale factor in the lower left corner of the window).
7. Now click the Cycle Images button to successively display the original, engraved, and simulation images. Note that the three images have been enlarged by the same amount and are in registration to facilitate comparisons among the images.
8. Click with either mouse button anywhere on the gray area surrounding the displayed image. The display should now, after a short delay, show the entire image. (The image can also be de-magnified in steps by clicking on the image with the right mouse button).
9. “Click and drag” on the image to define a rectangular area that you want magnified. After
releasing the mouse button and after a short delay, the selected portion of the image will be
magnified to fill the image area.

10. You can Cycle Images again if desired. When done, click on the gray area so the display
shows the entire image.

11. The simulation image and the ability to magnify and to cycle among the original,
engraved, and simulation images has been designed to help you decide whether or not the
engraved image is a good representation of the original (input) image on the engraving
material you have chosen (cherry wood in this scenario).

At this point, either continue with scenario 3 or click Exit to exit the PhotoGrav program.

Scenario 2 Notes:
**Scenario 3: Generating a PhotoGrav Report**

This scenario will demonstrate how to generate a PhotoGrav report that completely describes the current engraving session. The scenario will also demonstrate several other PhotoGrav features.

1. If you are continuing here from Scenario 1 or Scenario 2, then go to the next step. Otherwise, repeat the first eight steps of Scenario 1.

2. Click the blue **Info** button located near the left end of the Taskbar which is itself located near the top of the window. The **Info Report** window should open.

3. Click the blue "?" button near the upper right corner of the **Info Report** window. The cursor should change to a "?".

4. Position and click the "?" cursor anywhere on the darker-gray portion of the **Info Report** window. A dialog box should appear which describes the layout of this window.

5. Read the dialog box and then click on it to make it disappear.

6. Click on the vertical scroll bar to the right of the light-gray portion of the **Info Report** window to make the remainder of the report visible.

7. Click on the lightest-gray box titled **Engraver's Comment**. Type in a comment such as: *This session used the standard parameters for cherry wood.*

8. Click the **Print Report** button near the bottom of the window. A standard Windows dialog box should appear allowing you to select a printer (if you have more than one) and to set the options for the selected printer. Your report should be printed after clicking **OK** in the standard dialog box.

9. Click the **Close** button near the bottom of the window and the **Info Report** window should disappear.

10. Note the gray **Status Bar** panels at the bottom of the **Engraving Results** window. For most PhotoGrav windows, the left panel contains the input image name. However, for this window, the panel identifies which of the three images (original, engraved, or simulation) is currently visible and also shows the scale factor for the displayed image. The center panel displays either the engraving material or the laser engraver parameters. Click the panel to alternate between the two. The right-most two panels display the current date and time.

    At this point, either continue with Scenario 4 or click **Exit** to exit the PhotoGrav program.
Scenario 3 Notes:
Scenario 4: Adjusting Parameters in the “Interactive Process” Window.

This scenario will demonstrate how to adjust the parameters used in creating the engraved and simulation images. The Interactive Process window is extremely powerful, but also a little complicated so this scenario will just demonstrate some, not all, of the features available in the Interactive Process window. This scenario will also demonstrate how to save a Named Parameter Set.

1. If you are continuing here from Scenario 1, 2, or 3, then go to the next step. Otherwise, repeat the first eight steps of Scenario 1.

2. Click the ReProcess button located at the left end of the Taskbar which is itself located near the top of the Engraving Results window. This action hides the Engraving Results window and displays the Interactive Process window. (The Interactive Process window can also be entered from the initial Input Selection window by clicking the Interactive Process button.)

3. Components of the Interactive Process window:

   The input image is displayed in the left box and the output image (usually the simulation image) is displayed in the right box.

   The five green “function boxes” in the vertical center of the screen represent the processing functions that are applied to the input image. If a box is green, that function is “ON”. If the box is white, that function is “OFF”. Right clicking a box toggles the function ON/OFF.

   The larger panel near the center bottom of the window displays the processing parameters for one of the “function boxes” (The one surrounded by a rectangular, dashed outline). Left clicking a “function box” makes its parameters visible in the larger panel.

4. Left click the right-most green function box (contains text: “Simulation - ON”). The larger center panel should now be labeled “Simulate Engraving”. This panel displays the parameters used to control the generation of the simulation image.

5. Within the “Simulate Engraving” panel, click the “Power” scroll bar (in the light gray area under the scroll box) until its value is 20%. Generally, clicking in the scroll bar area itself will change a “% scroll bar’s” value by 10% whereas clicking the up or down arrows changes it by only 1%. Note that the simulation image has gotten much lighter reflecting the lower power setting for the engraving.

6. In a similar fashion, click the “Speed” scroll bar until its value is 30%. Note that the
simulation image is now about the same darkness as was the case when Power was 70% and Speed was 100%.

7. Right click the right-most green “function box” (contains text: “Simulation - ON”). The box should turn white indicating that the simulation function is off. Note that the right image display now shows the engraved image with no simulation. Right click the box again to toggle it back ON.

8. Now click the Save Params button located in the lower right portion of the screen. A standard Windows dialog box for saving files will appear. Type a name like “junk.prm” in the “File Name” box and then click OK. A dialog box should then appear that allows you to type in a description for this new Named Parameter Set. Enter whatever descriptive comments you want and then click OK. You have thereby saved all the processing parameters, including the engraving material, that have gone into producing the engraved and simulation images. This Named Parameter Set can be applied to any image at any time in the future to produce similar engraving results.

9. Near the lower right of the window, click the Proceed button to leave the Interactive Process window and enter the Engraving Results window.

10. There are many other functions and features available in the Interactive Process window. See Section 3.2 of this PhotoGrav User Guide for a complete description of each of these functions.

At this point, either continue with Scenario 5 or click Exit to exit the PhotoGrav program.

Scenario 4 Notes:
Scenario 5: Resizing the “canvas” for an engraved image.

This scenario will demonstrate how to change the size of the “canvas” for an image that is to be sent to the laser engraver. In this context, “canvas” means the background area of the image. The scale of the photo itself is not changed, just the background area on which it resides. The demonstrated capability can be used to either enlarge or “crop” the image that is to be sent to the engraver.

1. If you are continuing here from Scenario 1, 2, 3, or 4, then go to the next step. Otherwise, repeat the first eight steps of Scenario 1.

2. In the TaskBar, located near the top of the Engraving Results window, click the Text/Resize button. The Engraving Results window should be replaced by the Text/Resize window.

3. Click the Resize button located on the TaskBar which is itself located near the top of the Text/Resize window.

4. A panel titled “Plaque Size” should now fill essentially the entire Text/Resize window.

5. In the frame titled “New Size”, change the “Height” text box to 4.00, i.e., we are going to resize the image so it is 4.00” X 4.00”.

6. Make sure that the “FreeForm Positioning” option button is selected and that, in the “Fill Color for New Areas” panel, the option button is selected for the brown color, not the black. (The two colors correspond to the unburned and burned colors, respectively, for the image.)

7. Click the OK button. The simulation image should then be displayed “on top of” a green rectangle that represents the new “canvas” size.

8. Click and hold on the simulation image and drag it so that its upper left hand corner abuts the bevel indicator near the upper left hand corner of the green rectangle.

9. Click OK. After a short delay, the newly-sized simulation image should now appear.

10. At this point, one could click the Finished button on the TaskBar and could then save the engraved or simulation image to disk. If you want to continue with Scenario 6, do NOT click the Finished button.

At this point, either continue with Scenario 6 or click Exit to exit the PhotoGrav program.
Scenario 5 Notes:
**Scenario 6: Adding text to a resized image.**

This scenario will demonstrate how to add text to an image that has been processed and is to be engraved. PhotoGrav's text capabilities are somewhat limited and are intended primarily for engravings in which the main focus is the photo and that photo is to be supplemented with a few simple captions. However, although limited, PhotoGrav's text capabilities can be quite powerful in those cases where engraving polarities have to be reversed and the engraving has to be "mirrored" before engraving. In these cases, PhotoGrav's simulation image can be a powerful aid in positioning text and ensuring that it is indeed in the "right" polarity. Black Laser Brass and various acrylics are examples of materials for which PhotoGrav's text capabilities are very handy.

1. If you are continuing here from Scenario 5, then go to the next step. Otherwise, repeat the first eight steps of Scenario 1 and the first nine steps of Scenario 5.

2. Click the **Add Text** Button in the center of the TaskBar. A panel should appear titled "Specify Plaque Caption".

3. Select a font, e.g., Arial, from the left-hand list box. Select a size, e.g., 36 from the right-hand list box and click the option button corresponding to "black" in the "Text Color" box.

4. Click in the white box labeled "Enter Caption Below:" and type in that box: **Robert Reader**.

5. Click the **OK** button and the caption "Robert Reader" should appear on the simulation image in a blue color. The blue color indicates this caption is selected and can be positioned anywhere on the simulation image by clicking and dragging it.

6. When satisfied with the positioning, click on the simulation image away from the caption. The caption should change color from blue to the color you chose for it, i.e., black.

7. Click "**Add Text**" again. When the "**Specify Plaque Caption**" panel appears, change the size to 14 and the **Text Color** option button to brown.

8. Click in the white box and enter the caption: **suit lapel**.

9. Click **OK** and the caption "suit lapel" should appear on the simulation image in a blue color. Position this caption to a dark area of the suit lapel and then click elsewhere on the simulation image. The text color should change from blue to the color you chose for it, i.e., brown.

10. Click the **Finished** button. After a short delay, the engraved (binary) image is displayed.
11. You can toggle back and forth between the engraved and simulation image by clicking the
"Display Simulation" button in the center of the TaskBar (The caption of this button
alters between "Display Simulation" and "Display Engraved").

12. At this point, you can save the engraved and simulation images to disk by clicking the
appropriate button on the TaskBar (or via selections on the File menu).

13. Click the Exit button to exit the PhotoGrav program.

Scenario 6 Notes:

The six scenarios presented above have demonstrated only a small, albeit important, portion of
PhotoGrav’s capabilities. The following chapter of this guide, Chapter 2, provides an Operational
Overview of PhotoGrav and describes some basic PhotoGrav concepts. Chapters 3 and 4 then provide a
detailed and comprehensive description of all of PhotoGrav’s windows and capabilities.
Chapter 2
Operational Overview

2.0 Introduction

The objective of this chapter is to present the essential information that you need to know in order to effectively use PhotoGrav. Section 2.1 briefly describes PhotoGrav's primary windows and the flow of events that those windows support during a typical session. Section 2.2 provides a concise, high-level description of the program's concepts and the rationale for those concepts. Finally, section 2.3 presents a list of items that summarize the important information about PhotoGrav.

2.1 Flow of Events

PhotoGrav employs a small number of primary windows to functionally organize the major steps involved in engraving a photograph. Each primary window has one or more major functions to accomplish and, upon completion of those functions, control passes to the next primary window in the flow of events. Figure 2.1-1 illustrates the normal flow of events in PhotoGrav processing.

![Auto Process Diagram](image)

Fig. 2.1-1: PhotoGrav Flow of Events

The Input Selection Window provides the capability to select the image that you want to engrave and the engraving material that you want to use. PhotoGrav stores a set of processing parameters with
each material that it models. These processing parameters are optimized for each particular material to ensure excellent engraving results without any user intervention. These optimized parameters make possible the “Auto Process” path indicated in Fig 2.1-1.

The **Interactive Process Window** provides the capability for you to specify parameters for all of PhotoGrav’s processing functions and to view the result in near real time. Most importantly, you can view a simulation of what the engraving would actually look like on the material that you have selected. Although the **Interactive Process Window** provides complete access to PhotoGrav’s functions that have been tuned specifically for Laser Engravers, you will probably find that you can seldom do better than PhotoGrav’s Automatic Processing option.

The **Engraving Results Window** displays the Original (Input) image, the Engraved image (the image that is to be used for engraving), and the Simulation image (what the engraving will look like on the chosen material). The images appear on the screen one at a time but you can click a button to rapidly cycle through them for comparison purposes. You can also magnify the images by clicking near the center of the area you want magnified or by defining a rectangular area to be enlarged to fill the screen. All three images are magnified by the same amount so comparisons are still easy to do even after magnification. From the **Engraving Results Window** you can save the Engraved image on disk for later transfer to your engraver or you can proceed to the **Text/Resize Window**.

In the **Text/Resize Window** you can add any number of text captions to the engraving using any of the fonts available on your computer. In this window you can also "crop" the Engraved image or enlarge the area of the material on which the engraved photo is to reside. The engraved photo can then be positioned anywhere on the resized area.

Although Fig. 2.1-1 illustrates the "normal" flow of events within PhotoGrav, other event paths are also possible and other "Support" Windows are available. For example, Fig. 2.1-2 illustrates that one can reprocess an image after inspection in the **Engraving Results Window** by taking the "Reprocess" path from that window to the **Interactive Process Window**. The initial values of the processing parameters upon entry to the **Interactive Process Window** are those that were used to create the images just viewed in the **Engraving Results Window**.

---

**Fig. 2.1-2:** "Reprocess" and "New Image" Flow of Events

2-2
Figure 2.1-2 also illustrates that the **Input Selection** window can be re-entered from either the **Engraving Results** or **Text/Resize** window in order to begin processing a new image once processing has been completed for the current image.

---

### 2.2 Basic PhotoGrav Concepts

The objective of the **PhotoGrav** program is to efficiently process digitized photographs so they can be engraved on a variety of common engraving materials with a high degree of confidence that the engraved photographs will be acceptable products. This objective is achieved via two basic **PhotoGrav** concepts:

1. Processing operations that are "tuned" for each engraving material, and
2. A simulation of the engraved image

The intent of this section of the user guide is to provide a concise, high-level description of these two concepts and their underlying rationale. A more detailed description can be found in "Appendix 5: **PhotoGrav Concepts and Design**".

**PhotoGrav**'s processing operations were designed and developed specifically to process images for laser engraving and were parameterized so that a wide range of effects could be achieved by adjustment of the parameters. Then the parameters were individually "tuned" for each of the engraving materials supported by the program. This "tuning" was accomplished experimentally, using several test images, by specifying several sets of parameters for each engraving material, actually engraving the images on the material, and evaluating the resulting engravings. This process was repeated until the resultant engravings appeared to be near optimal for the subject material. The parameters that produced the final, "near optimal" engraving were then recorded and a data set was created for the material. These data sets are stored as part of the description of each engraving material and are automatically retrieved whenever a material is selected as the current engraving material within **PhotoGrav**.

Although the tuning process described above results in "near optimal" parameter settings for each engraving material, engraving results are still often somewhat image dependent. In other words, the settings that produce an excellent engraving for one image on a specific material might result in an engraving that is less satisfactory for another image using the same engraving material. Further, it is very difficult to view the raw processed image on a computer monitor and to judge from that display whether or not the final engraving will be satisfactory. To overcome these difficulties, **PhotoGrav** provides, optionally, a simulation of what the processed image will look like once it is actually engraved on the selected material.

**PhotoGrav**'s simulation capability is intended to provide a **WYSIWYG** (What You See Is What You Get) capability. In other words, the appearance of the simulated image on your computer monitor should be very close to the appearance of the actual engraving produced from the processed image. The simulated image is not merely an overlay of "dots" on top of a representation of the engraving material.
Rather, it is a full-fledged simulation wherein a lens-power model, calibrated for each material, is used to calculate an effective laser spot size which is then "burned" into a representation of the engraving material. Further details about the simulation and model can be found in Appendix 5.

The Simulation Image produced by PhotoGrav should always be a representation of the final engraving. For example, for "Black Laser Brass", the Simulation Image should appear with proper polarity even though the processed image, if displayed in its "raw" form, would appear to have a "negative" polarity. There is one special case of this WYSIWYG capability that should be noted. For acrylics, which are normally engraved on the "back" of the material, the Simulation Image produced by PhotoGrav is the view from the "front" of the material, i.e., the normal viewing perspective. So, even in this special case, the Simulation Image produced by PhotoGrav is a true WYSIWYG representation, i.e., the simulated engraving is presented as it would normally be viewed by your customers as a finished product. Although the primary utility of the Simulation Image is to help you make fine adjustments to create a more satisfactory engraving, it can also be printed and used for customer proofs or as supplements to file copies of your shop's projects. The prints are especially effective if you have a color printer attached to your computer.

Although the simulation model has been calibrated for a variety of laser engravers and for many common engraving materials, there are bound to be variables that at times cause noticeable differences between PhotoGrav's Simulation Image and the actual engraving. For example, black laser brass from different manufacturers, or even different "batches" from the same manufacturer, will sometimes engrave somewhat differently under identical engraver settings. Also, variables in the laser engraver itself, e.g., dirty lenses or mirrors, can cause variations in the engraving performance. You should try to control these variables to the degree possible and also realize that PhotoGrav, like any other tool, requires some some practice and skill on your part to adapt its capabilities to your particular environment and requirements. It is also important to remember that, for engraved photographs, "beauty is in the eye of the beholder", i.e., the perceived goodness of an engraving is a very subjective measure. You might therefore find that PhotoGrav's processing parameters for a particular material do not result in engravings that match your tastes. If so, use PhotoGrav's interactive processing capabilities (see Sec. 3.2) and its Named Parameter Sets to define things the way you want them to be.

One other aspect of PhotoGrav's operational characteristics requires some discussion before concluding this section. In the Engraving Results window (see Fig. 2.1-1), PhotoGrav displays the Original Image, the Engraved Image, and the Simulation Image for comparison purposes. The Original Image is the input image and the Engraved Image is the processed binary image that is to be sent to the engraver. The Engraved Image is normally displayed in the same polarity and the same left-to-right orientation as the Original Image even though those characteristics might be automatically changed by PhotoGrav when the image is saved on disk for transfer to your engraver. The reason for displaying the Engraved Image in this fashion is merely to facilitate the comparison to the input image. If this is a bit confusing, just remember that the Simulation Image always represents what will be engraved if you save the processed image (Engraved Image in PhotoGrav's terminology) to disk and transfer it to the engraver with no changes.
2.3 Important PhotoGrav Information

The following is a collection of important things that you should know about PhotoGrav. Some of the items have already been discussed in previous sections and some of them will be covered in later sections. However, since much of the information following Chapter 2 is very detailed and is intended as reference material, the essential elements of that information are summarized below so you can begin using PhotoGrav with confidence after reading this section. If an item is discussed elsewhere in this document, then a reference to the appropriate section is included below.

1. Your display monitor (video card) MUST be set up to display a pixel depth (color palette) of at least 15 bits per pixel. See section 1.2 of the PhotoGrav User Guide for instructions on how to do this. Also, PhotoGrav "looks better" if run at a "desktop size" of 1024 x 768 or 800 x 600 but will run adequately at 640 x 480. (Reference: Sec. 1.2)

2. The input image ("Original Image") for PhotoGrav MUST be an 8-bit grayshade image in Windows .bmp file format. The image should NOT be an "indexed color" or true color image. Most image processing programs, and scanning software, will provide the capability for you to save an image as a grayshade image (sometimes called a black & white photo) in .bmp format. (Reference: Sec. 3.1.2)

3. The input image to PhotoGrav should be scanned, or resampled in some image processing program such as CorelDraw or Adobe PhotoShop, so that its size and resolution (dpi) are "correct" (see below).

The dpi (dots per inch) for the image should be the same, or an integer factor or divisor, of the dpi at which you intend to engrave the image. For example, if you intend to engrave at 250 or 500 dpi, then the image should be scanned at 250 dpi. If you intend to engrave at 300 or 600 dpi, then the image should be scanned at 300 dpi. Engraving results can often be very disappointing otherwise.

The size of the image, at the scanned resolution (dpi), should be the desired size of the final engraved image. PhotoGrav does provide cropping and "canvas" enlargement (in its "Text/Resize" window) but does not change the "scale" of the input image.

4. Processed photographs (PhotoGrav's "Engraved Image") should be engraved using the highest resolution lens (smallest spot size) that you have available. If you do not own your manufacturer's "high-resolution lens" and if you intend to engrave a lot of photographs, then you might consider obtaining such a lens.

5. Use PhotoGrav's "Preferences" window to set the parameters and characteristics for your
specific laser engraver. The "Preferences" window is accessible from the File menu in the "Input Selection" window.  

(Reference: Sec. 4.1)

Although you specified your Laser Engraver model and its maximum power on your very first PhotoGrav execution, there are other parameters that further define your specific machine. In particular, within the "Preferences" window, you should add and/or delete lenses from the Lenses" list to match your set of lenses. If you have more than one lens and always want PhotoGrav to model a specific lens, then check the "Always Use" box and enter the proper value in the textbox. Similarly, the list of "dpi's" should be edited to reflect the dpi settings available on your machine and an "Always Use" value should be set if so desired.

6. PhotoGrav does not "Print" directly to laser engravers. To engrave a PhotoGrav-processed image (the "Engraved Image"), save the "Engraved Image" to disk and use your standard program, e.g., CorelDraw, to send the image to the engraver.  

(Reference: Sec. 3.3)

7. DO NOT RESIZE NOR Rotate the "Engraved Image" (the PhotoGrav-processed image to be sent to the engraver) in CorelDraw, or any other image processing program, before sending it to your engraver. The "Engraved Image" is a binary image, as it must be for laser engraving, and resizing and rotation operations in general do not work well for binary images.

8. PhotoGrav's "Named Parameter Sets" provide a powerful mechanism whereby you can customize PhotoGrav's parameters to achieve the results you want and can be assured that those results are repeatable in the future. If PhotoGrav's "Auto Process" parameters do not provide a satisfactory result for a specific material, then use the "Interactive Process" window to create "Engraved Images" at several parameter settings that you suspect might be better. Save the settings as "Named Parameter Sets" and then actually engrave the images. Choose the engraving you prefer and then delete the Named Parameter Sets that do not correspond to that "best" engraving. If satisfied with the "best" engraving, note which parameter set was used and/or rename it so you can readily access it in the future for similar engraving projects. Otherwise, repeat the process until the results are satisfactory.  

(Reference: Sec. 3.2)

9. The engraving material to be modeled is generally selected in the "Input Selection" window after opening the digitized photograph that is to be engraved. However, it is often convenient to change the engraving material in the "Interactive Process" window. This can be accomplished by
clicking the "Load Params" command button in that window and accessing one of the standard PhotoGrav Named Parameter Sets which correspond one-to-one with the engraving materials and which are located in the \Params subdirectory of the PhotoGrav root installation directory. The correspondence between the parameter set file names and the engraving materials is listed below: (Reference: Sec. A1.1)

<table>
<thead>
<tr>
<th>File Name</th>
<th>Engraving Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acrylic.prm</td>
<td>Clear Acrylic (cast type)</td>
</tr>
<tr>
<td>Alumbblk.prm</td>
<td>Anodized Aluminum (Black)</td>
</tr>
<tr>
<td>Bgldblki.prm</td>
<td>Brushed Gold/Black - IP1 Brand #LZ-990</td>
</tr>
<tr>
<td>Bgldblks.prm</td>
<td>Brushed Gold/Black - Spectrum Lights</td>
</tr>
<tr>
<td>Blkacryl.prm</td>
<td>Black Painted Acrylic</td>
</tr>
<tr>
<td>Blkbcss.prm</td>
<td>Black Laser Brass</td>
</tr>
<tr>
<td>Bwplstc.prm</td>
<td>Black/White - IP1 Laser Plastic #LZ901</td>
</tr>
<tr>
<td>Chamois.prm</td>
<td>Chamois Leather (Cod Oil Tanned)</td>
</tr>
<tr>
<td>Cherry.prm</td>
<td>Cherry with light vertical grain</td>
</tr>
<tr>
<td>Grygrnt.prm</td>
<td>Granite, Gray Spectralite Brand</td>
</tr>
<tr>
<td>Lrmdbnm.prm</td>
<td>Medium Brown Rough Leather</td>
</tr>
<tr>
<td>Lrmrdgy.prm</td>
<td>Medium Gray Rough Leather</td>
</tr>
<tr>
<td>Lrmrntn.prm</td>
<td>Medium Tan Rough Leather</td>
</tr>
<tr>
<td>Lsmrned.prm</td>
<td>Medium Red Smooth Leather</td>
</tr>
<tr>
<td>Lsmrntn.prm</td>
<td>Medium Tan Smooth Leather</td>
</tr>
<tr>
<td>Udplstcb.prm</td>
<td>User-Defined Cap/Black Core - Plastic</td>
</tr>
<tr>
<td>Udplstcw.prm</td>
<td>User-Defined Cap/White Core - Plastic</td>
</tr>
<tr>
<td>Walnut.prm</td>
<td>Walnut with vertical grain</td>
</tr>
<tr>
<td>Wbplstc.prm</td>
<td>White/Black - IP1 Laser Plastic #LZ902</td>
</tr>
</tbody>
</table>

The Simulation Image for the material "Clear Acrylic" is assumed to be viewed as if the engraving were placed in front of a black background so "clear" areas show up as black.

10. The leather materials included with PhotoGrav, unlike most of the other furnished engraving materials, are not standardized materials. Further, the engraving behavior of leather depends very much on the tanning process, whether the leather is oiled or not, etc. Therefore, PhotoGrav's Simulation Image for any specific leather material might not be a good representation relative to the specific leather material that you want to use. However, you can use the furnished material as a starting point for your own calibration process wherein you save your final, calibrated parameters as one of PhotoGrav's "Named Parameter Sets".

11. The list of engraving materials presented in item 9 contains two plastic materials that are "User-Defined Caps" with white or black cores. These materials can be used to model just about any plastic with a solid-color cap and with either a black or white core. Some
12. Two copies of PhotoGrav cannot be running at the same time. If PhotoGrav refuses to start, there is probably another copy of it running in a minimized window. Either restore the minimized window to normal size and use it or close that copy to start a new PhotoGrav execution. (Reference: Sec. 6.1.1.1)

13. PhotoGrav produces temporary image files during its execution that can become quite large if the input image is large. Try to maintain a reasonable quantity of free disk space on the hard disk where you installed PhotoGrav (50 MB should be adequate for most purposes).

14. PhotoGrav is a 32-bit program which runs equally well under Windows 98, Win2K, WinME or WinXP.
Chapter 3
Primary Windows

3.0 Introduction

Chapter Two described how PhotoGrav uses several primary windows to provide a smooth flow of events within a PhotoGrav session. This chapter, Chapter Three, provides a detailed description of each of those primary windows. The description includes: (1) An overview schematic of each window with labels specifying the major components of the window, (2) a brief description of the main functions of the window, (3) a detailed description of the controls that reside within the window, (4) a description of the menu items for the window (Generally, menu items correspond one-to-one with specific controls which are described in more detail), and (5) the contents of the Status Bar for this window.

The name of each PhotoGrav Window occurs to the left in the window’s Title Bar (right next to the PhotoGrav icon). It is a good idea to become familiar with the primary windows’ names since the documentation refers extensively to these windows.

3.1 Input Selection Window

3.1.1 Functions

PhotoGrav execution starts, after an initial opening screen, in the Input Selection window (see Fig. 3.1-1). The primary functions provided by the Input Selection window are: (1) Selection of an input image, (2) Selection of an engraving material (either explicitly chosen or implicitly defined by the selection of a Named Parameter Set), and (3) Initiation of interactive or auto processing functions. This window also provides access to the Preferences window (for selecting PhotoGrav options) and provides the capability to change, temporarily, the dpi (dots per inch) of an image.
3.1.2 Controls

**TaskBar Command Buttons** (from left to right across the TaskBar)

- **Open Image**: Opens the image to be engraved. The image MUST be a grayscale image in .BMP format. Most image processing programs, such as CorelDraw & Adobe PhotoShop, will convert other formats to the .BMP format.

- **Close Image**: Closes the current image and removes it from the screen.
TaskBar Command Buttons (cont.)

**Load Params**
Loads a Named Parameter Set from disk. A Named Parameter Set specifies a previously-saved engraving material and the parameter settings used for engraving on that material. Named Parameter Sets optimized for various materials are supplied with PhotoGrav and exist in the subdirectory `\PARAMS`.

**Info**
Displays all available information about the input image, engraving material, processing parameters, and the Laser Engraver parameters currently being modeled by PhotoGrav. The information can be printed by choosing the **Print Report** button that appears on the information display or by choosing the **Print Information** item on the **File** menu.

**Select Material**
Presents a list of common engraving materials from which you choose one for the PhotoGrav simulation. All materials are accompanied by processing parameters optimized for the particular material.

**Modify Material**
Allows you to select an engraving material and to then modify its appearance (brightness, contrast, and color). After selecting this option, you must either **Interactive Process** or **Auto Process** the currently selected image.

**Interactive Process**
Proceeds to the **Interactive Process** window where you can interactively adjust the processing parameters and see the effect in real time.

**Auto Process**
Processes the image with currently existing parameters and displays the original, engraved, and simulation images for comparison in the **Engraving Results** window.

**?**
Provides context-sensitive Help for any enabled control. Left clicking the “?” causes the cursor to change into a “?” symbol. Position the “?” cursor on a control about which you want information, click, and a dialog box appears with the information. When finished reading the information, click the dialog box to make it disappear.

**EXIT**
Exits the PhotoGrav program after checking if that is really what you want to do. However, no check is made if the **Minimize Cautionary Messages** checkbox is checked in the **Preferences** window.

### 3.1.3 Menus

The **Menu Bar** contains the following Menu Headings:
Each of these menus is listed and described in the following.

**File Menu**

<table>
<thead>
<tr>
<th>Open Image</th>
<th>1. C:\PHOTOGRV\SAMPLES\IMAGE300.BMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Image</td>
<td>2. C:\PHOTOGRV\SAMPLES\IMAGE250.BMP</td>
</tr>
<tr>
<td>Change Image dpi</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Load Parameters</th>
<th>Last Session's Saved Parameter Sets</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. C:\PHOTOGRV\PARAMS\ACRYLIC.PRM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
</tr>
</tbody>
</table>

| Exit |

The second section from the top in the **File Menu** contains the names of (up to) the last six images that have been Opened and the fourth section from the top contains the names of (up to) the last six Named Parameter Sets that have been loaded. A single left click on one of the names will load the respective image or named parameter set.

With the following exceptions, the **File Menu** items perform the same actions as the identically named **TaskBar** command buttons.

The **"Change Image dpi"** item will change the dpi (dots per inch) of the input image and any images produced from it. The input image, however, will retain its original dpi when PhotoGrav execution ceases whereas any product images that are saved on disk will keep the new dpi assignment.

The **"Print Information"** item will print the same information that can be displayed by clicking the **Info** command button (the displayed information form also contains a "Print" button which can be used to send the displayed information to the printer).

The **"Preferences"** item causes the **Preferences window** to be displayed. That window can be used to change the Laser Engraver parameters (lens, dpi, etc.) and can also be used to change many of PhotoGrav's optional settings (See Chapter 4 for a complete description of the **Preferences window**).
Tools Menu

Select Engraving Material
Modify Engraving Material

Interactive Process
Automatic Process

These Tools Menu items perform the same actions as the similarly-named TaskBar command buttons.

View Menu

View Information

Hide Tool Bar

The “View Information” item performs the same action as the Info command button on the TaskBar. The “Hide Tool Bar” item causes the Tool Bar (also called the TaskBar) to be hidden. The image display, if any, becomes correspondingly larger when the TaskBar is hidden and the menu item becomes “Show Tool Bar”.

Help Menu

Table of Contents
“Input Selection” Window
Search for Help On...
How to Use Help

About PhotoGrav

The “Table of Contents” item displays the Table of Contents for the PhotoGrav narrative On-Line Help system. The “Input Selection” Window item displays that portion of the On-Line
Help system that describes the Input Selection window. The “Search for Help On . . .” item displays the usual Window’s Help Search dialog box whereby “Help” can be requested for specific terms or phrases. The “How to Use Help” item presents a brief tutorial on how to use the Window’s Help System for PhotoGrav. The item “About PhotoGrav” displays a small window presenting information about the version number and creation date of your copy of PhotoGrav and your ownership information including the serial number of your copy of PhotoGrav. This window also displays a short animation of a laser engraving in progress.

The Help Menus for all PhotoGrav windows are identical, except for the window-specific help item, and will not be repeated for subsequent windows.

3.1.4 Status Bar

The Status Bar consists of four panels. The first panel from the left contains the name and complete path of the input image. The second panel from the left toggles between: (1) the engraving material (followed by a hyphen and a Named Parameter Set name if any is active) and (2) the laser engraver name and the settings for the engraver. Clicking the panel will cause it to alternately display one of these two items. The last two panels contain the current date and time, respectively.
3.2 Interactive Process Window

3.2.1 Functions

This window (see Fig. 3.2-1) provides the capability for you to specify or adjust the parameters for all of PhotoGrav's processing functions and to view the results in near real time. The Original (input) image is displayed in the upper-left portion of the window and the processed image is displayed in the upper-right portion of the window.

The five white boxes aligned horizontally in the center of the screen represent PhotoGrav's processing functions and the order in which those functions are applied. Right clicking on any of the boxes will toggle the corresponding function ON/OFF. Left clicking on any of the boxes causes the parameters corresponding to that function to be displayed in the large center panel near the bottom of the window (the panel indicated in Fig.3.2-1 as Processing Function Parameters).

![Interactive Process Window](image_url)
3.2.2 Controls

3.2.2.1 Major Controls

Unlike PhotoGrav’s other primary windows, the Interactive Process window does not have a TaskBar near the top of the window. Rather, the major command buttons are collected in a panel near the lower right portion of the window. These command buttons, along with several other controls which are general in nature, are described in this Section. Other controls, unique to each of PhotoGrav’s processing functions (Adjust Gray, Enhance, Screen, Threshold, and Simulation), are described in Section 3.2.2.2 which follows this section.

Load Params

Loads a Named Parameter Set from disk. A Named Parameter Set specifies a previously-saved engraving material and the parameter settings used for engraving on that material. Named Parameter Sets optimized for various materials are supplied with PhotoGrav and exist in the subdirectory \PARAMS. Hint: By loading a Named Parameter Set, you can change the engraving material that is currently being modeled without returning to the Input Selection window.

Save Params

This command button saves the current processing parameters, including the engraving material, as a Named Parameter Set on disk. The saved Named Parameter Set can subsequently be used for other images that you want to engrave using the same parameters and the same material as those currently being used.

Restore

This command button restores the processing parameters to those values that they had:

1. upon entry to the Interactive Process window, OR
2. when the last Named Parameter Set was loaded during this visit to Interactive Process OR
3. when the last Named Parameter Set was saved during this visit to Interactive Process,

depending on whichever event occurred latest.

Big Images

If this box is checked, larger "thumbnails" are displayed as the Left & Right images above. Processing proceeds almost as fast for larger thumbnails as it does for smaller ones so it is recommended that this box be checked most of the time.

High Quality

If this box is checked, then the Left & Right "thumbnails" are displayed with higher quality than if the box is not checked. Quite perceptible differences can be observed for "High Quality" if the Thresholding function is ON and the Simulation function is OFF. "High Quality"
adds a perceptible time lag to interactive processing so it is recommended that this box be unchecked most of the time. It is, however, handy to check "final results". Whether or not this box is checked has NO EFFECT AT ALL on the final engraved image. It has an effect only on the "thumbnail" presentations in this window.

**Proceed**

This command button signals PhotoGrav to accept the current processing parameters and to produce full-sized engraved & simulated images. The full-sized images are presented for inspection and for comparison to the Original image in the Engraving Results window which appears automatically after clicking this Proceed button.

**Exit**

Exits the PhotoGrav program after checking if that is really what you want to do. However, no check is made if the "**Minimize Cautionary Messages**" checkbox is checked in the **Preferences** window.

**Synchronized**

(Check box located in the upper-center portion of the window) Specifies whether or not the Left & Right thumbnail displays are synchronized. If the box is checked, the Left & Right displays show the same area of the Original & Processed images, respectively. If the box is unchecked, the Left display shows the entire Original image with a yellow box indicating what area of the Processed image is being shown on the right display.

?  

(Located in the upper-right corner of the window) Provides context-sensitive Help for any enabled control. Left clicking the "?" causes the cursor to change into a "?". Position the "?" cursor to a control about which you want information, click, and a dialog box appears with the information. When finished reading the information, click the dialog box to make it disappear.

**Left** clicking on the thumbnail display of the **Processed Image** (thumbnail to the right) will cause the portion of the image surrounding the clicked point to be magnified and the display to be centered on the "clicked" point. **Right** clicking will cause the display to be de-magnified in a similar fashion. One can also "click and drag" to define a rectangular area to fill the entire thumbnail display. Clicking in the gray panel surrounding the thumbnail will cause the entire image to be displayed.

The behavior of the **Original (Input) Image** thumbnail display (thumbnail to the left) is dependent on whether or not the **Synchronized** checkbox is checked as discussed above. The scale factors of both thumbnail displays are shown in the small gray panel near the top center of the window. The scale factors indicate how much the image data had to be magnified or reduced *in each dimension* in order to fit the thumbnail. For example, a scale factor of 0.5 indicates that only every other pixel is displayed. A scale factor of 2.0 indicates that two pixels are displayed for each pixel in the image.
Left clicking on the box labeled "Image In (Click)" near the left center of the window will cause the Original (input) image parameters to be displayed in the larger panel near the lower-left portion of the window. Left clicking the box again will normally cause the Laser Engraver specifications to be displayed in the same larger panel. However, if the "Adjust Gray" function is active, then a text box appears which will display the x- and y-coordinates of the cursor position and the image gray shade at that location whenever the cursor is positioned within the "Image In" thumbnail located near the upper-left portion of the window.

Right clicking on any one of the five boxes which represent PhotoGrav’s processing functions (the five white boxes aligned horizontally in the center of the window in Fig 3.2-1) will toggle the corresponding function ON/OFF. When a processing function is ON, the corresponding box is green; when OFF, the box is white. Left clicking on any one of the five boxes causes the parameters corresponding to that function to be displayed in the large center panel near the bottom of the window (the panel indicated in Fig 3.2-1 as Processing Function Parameters). The panels containing the controls for all five of PhotoGrav’s processing functions are displayed and described in the following Section 3.2.2.2.

3.2.2.2 Processing Function Parameters and Controls

PhotoGrav has five major functions whereby it transforms an Original (input) image into Engraved and Simulation images. Whenever one of the boxes corresponding to these functions is Left clicked, the parameters and controls appropriate to that function are displayed in the larger panel near the center-bottom of the Interactive Process window. The parameters and controls for each of the five functions are displayed and described in the following.

3.2.2.2.1 "Adjust Grayshade" Processing Function

The panel corresponding to the "Adjust Grayshade" processing function is shown in Fig. 3.2-2. This panel can be made visible by Left clicking the "Adjust Gray" function box near the left-center portion of the Interactive Process window depicted in Fig. 3.2-1.

![Adjust Grayshade Function](image-url)
The graph in the middle of the panel is a histogram, or distribution, of the gray shades in the Original (input) image. The horizontal axis ranges from zero (black) on the left to 255 (white) on the right. The height of the distribution indicates the relative number of image elements (pixels) that have the gray shade indicated by the corresponding point on the horizontal axis. (If a distribution is very "peaked" at certain gray shades, then the peaks are truncated and other heights scaled to prevent the peaks from totally dominating the distribution). As an example, for the distribution displayed in Fig. 3.2-2, there are many more brighter gray shades than darker gray shades.

The left and right triangles below the horizontal axis specify the black and white clipping values, respectively, for the "Adjust Grayshade" function, i.e., all grayshades to the left of the left triangle are set to black (zero) and all grayshades to the right of the right triangle are set to white (255) and the grayshades between are linearly scaled. The "Black" and "White" labels to the left of the distribution specify quantitatively the black and white clipping values (38 and 255, respectively, for the distribution in Fig. 3.2-2). The clipping values can be changed by "clicking and dragging" the triangles. As a result, the "Black" and/or "White" quantitative values will change and the effect will show up as a change in the Processed Image pictured in Fig. 3.2-1 as the right-hand thumbnail. The clipping values can also be changed by clicking the "Auto Gray" command button. This action causes PhotoGrav to calculate the "1%" clipping values for the grayshade distribution, i.e., the grayshade values between which lie 98% of all grayshades in the image. PhotoGrav then sets the triangles to these values and the resulting effect shows up on the Processed Image. (Note: All the engraving materials and named parameter sets delivered with PhotoGrav specify that the "Auto Gray" function be performed automatically so it is usually unnecessary to explicitly perform this function).

The middle triangle below the horizontal axis is the "gamma" for the gray shade transfer function. Changing the gamma value, by clicking and dragging the triangle, has the effect of simultaneously changing the brightness and contrast of the image. Moving the triangle to the right will generally make the Processed Image brighter and moving it to the left will generally make it darker.

The "Hist Eq Off" command button is a label and toggle button. When the caption on the button is "Hist Eq Off", as it is in Fig. 3.2-2, then the histogram equalization function has NOT been performed. Clicking the button when it has this caption will perform the histogram equalization function and will change the caption to "Hist Eq On". Histogram equalization attempts to spread the image's grayshades uniformly from black (zero) to white (255). When the function has been performed, the resulting histogram is plotted in green along with the "Raw" (unequalized) histogram. The histogram equalization function is occasionally useful for some images but it is not set ON for any of the materials or Named Parameter Sets delivered with PhotoGrav so you must turn it on manually if you wish to see its effect. (The function can be turned off by clicking the command button again).

The "On" check box in the upper right corner of Fig. 3.2-2 indicates that the "Adjust Grayshade" function is applied to the image data if the box is checked; otherwise the function is NOT applied to the image data and has no effect regardless of the parameter settings discussed above. Clicking this check box is equivalent to Right clicking the "Adjust Gray" function box pictured in Fig. 3.2-1 and discussed briefly in Section 3.2.1. If the "On" box is checked, the function box will be green; if it is unchecked, the function box will be white.
3.2.2.2 “Enhance Edges” Processing Function

The panel corresponding to the “Enhance Edges” processing function is shown in Fig. 3.2-3. This panel can be made visible by Left clicking the “Enhance” function box near the center of the Interactive Process window depicted in Fig. 3.2-1.

![Enhance Edges](image)

Fig 3.2-3: Enhance Edges Function

The “Enhance Edges” function provides the capability to both “smooth” the image and to enhance the image’s edges. As with the “Adjust Grayshade” function, if the “On” checkbox is checked, then the function affects the image data; otherwise, if unchecked, there is NO effect regardless of the parameter settings. If the function is ON, then the “Enhance” function box pictured near the vertical center of Fig. 3.2-1 should be green; otherwise, if the function is OFF, then the box should be white.

The “Extent” parameter pictured in Fig. 3.2-3 can be modified by entering a value directly in the appropriate white box (contains “12” in Fig. 3.2-3) or by clicking the horizontal scroll bar to the right of the “Extent” label. Clicking on an arrow at either end of the scroll bar changes the existing value by 1% whereas clicking in the scroll bar itself changes the existing value by 10%. The extent parameter specifies the relative size of the area around each pixel which is “smoothed”. Small values indicate relatively little smoothing whereas large values specify relatively large smoothing.

The “Strength” parameter specifies the degree to which edges are enhanced or emphasized. The “Strength” parameter is controlled in a manner similar to the “Extent” parameter except that its values range from -100% to +100% rather than 0% to 100%. Almost all of the useful settings for the “Strength” parameter are positive but interesting effects can sometimes be achieved with negative settings.

Although PhotoGrav automatically sets parameter values appropriate to each engraving material, it is a good idea for you to experiment with the “Extent” and “Strength” parameter settings to get a feel for their effect which at times can be rather dramatic. An interesting way to do this is to have the “Simulation” ON (see Fig. 3.2-1) and to turn the “Enhance Edges” function alternately ON and OFF to observe the effect.

3-12
3.2.2.3 “Select and Apply Screen” Processing Function

The panel corresponding to the “Select and Apply Screen” processing function is shown in Fig. 3.2-4. This panel can be made visible by Left clicking the “Screen” function box near the center of the Interactive Process window depicted in Fig. 3.2-1.

![Select and Apply Screen Panel]

**Fig 3.2-4: Select and Apply Screen Function**

**Diffusion Dithering**

The “Select and Apply Screen” function provides the capability to “screen” or “dither” the image in preparation for thresholding which follows this function. If the “On” check box in the upper right hand corner of Fig. 3.2-4 is checked, then the “Select and Apply Screen” function is ON and affects the image data; otherwise, if the box is not checked, there is no effect regardless of the parameter settings. If the function is ON, then the “Screen” function box near the center of Fig. 3.2-1 will be green; otherwise, if the function is OFF, then the box will be white.

The “Select and Apply Screen” function actually provides two major capabilities: (1) Diffusion Dithering and (2) Pattern Dithering. Figure 3.2-4 shows the appearance of the panel for the case in which Diffusion Dithering is selected (note the two option buttons near the top of the panel). The appearance of the panel for Pattern Dithering is depicted in Fig. 3.2-5 and that technique and its parameters will be described after the following discussion of Diffusion Dithering.

**Diffusion Dithering** is a technique to convert a grayscale image to a binary image (black & white only, no shades of gray) wherein the shades of gray in the original image are represented in the processed binary image by differing densities of black and/or white dots. Diffusion Dithering accomplishes this by converting each gray shade in the original image to either a black or white value depending on its value relative to a predetermined “threshold” value. The error in making this assignment is then “diffused” to neighboring pixels which eventually are also thresholded (and then error diffused) and so forth and so on throughout the entire image.

The Diffusion Dithering within PhotoGrav has been designed and optimized specifically for laser engraving and is controlled by the two parameters indicated in Fig. 3.2-4: (1) ED Density and (2)
Noise Gain. (The ED stands for Error Diffusion). The “ED Density” parameter can be used to darken lighter areas of the processed image without substantially affecting areas that are already dark and, vice versa, can be used to lighten darker areas of the image without substantially affecting areas that are already light. The “Noise Gain” parameter can be used to add noise to the image to reduce “contouring” or “repetitive pattern” effects that often occur when grayscale images are converted to binary images.

Both parameter values can be modified by clicking the scroll bars or by entering numeric values in the white text boxes directly above each scroll bar. Relative values for the “ED Density” parameter range from -100 (darken) to +100 (lighten). Relative values for the “Noise Gain” parameter range from 0% (no noise) to 100% (maximum noise). Clicking on an arrow in the scroll bars changes the parameter value by “1”; clicking within the scroll bar itself changes the parameter value by “10”.

Almost all of PhotoGrav’s defaults (engraving material specifications and Named Parameter Sets) specify “Diffusion Dithering” rather than “Pattern Dithering” as the “screening” technique. However, “Pattern Dithering” can at times be superior and that technique and its parameters are described below.

![Pattern Dithering](image)

**Fig 3.2-5: Select and Apply Screen Function**

Pattern Dithering is selected by clicking the right-hand option button of the two near the top of the “Select and Apply Screen” panel as depicted in Fig. 3.2-5. Selecting this button causes (after a slight delay) a different set of controls to appear than for Diffusion Dithering and that set of controls is pictured in Fig. 3.2-5.

There are five different patterns that can be utilized for “Pattern Dithering”. For the example in Fig. 3.2-5, the “Circular Dots” pattern has been selected as indicated by the text in the white box near the top center of Fig. 3.2-5. That box is part of a drop-down list and the remainder of the list can be made visible by clicking the down arrow at the right of the box. Clicking any item in the list will cause that item to become the selected pattern and will cause the list to collapse with the selected pattern’s name visible in the text box.
The five patterns provided with PhotoGrav are listed below:

Circular Dots
Lines
Crosshatch
Wavy Lines
Circles

There are four adjustable parameters associated with each of these patterns as indicated by the controls depicted in Fig. 3.2-5. All of the parameters can be adjusted by clicking on the horizontal scroll bars or by entering numeric values in the white text boxes directly above each scroll bar.

The “dpi” parameter specifies the resolution or the “coarseness” of the pattern. This parameter can range from “1” (very coarse) to “300” (very fine). The “Angle” parameter specifies the angle of the pattern relative to the horizontal axis with positive angles counterclockwise to that axis. This parameter can range from -90 to +90 degrees. The “Black Width” parameter is the “width” of pattern constituents (lines, dots, etc.) that does not change with changes in the grayshades of the Original (input) image, i.e., it is the “core” width of these constituents. This parameter can range in value from “1” (very thin) to “100” (very fat). The “Gray Width” parameter is the “width” of pattern constituents (lines, dots, etc.) that DOES change with changes in the grayshades of the Original (input) image, i.e., it is the adjustable width of these constituents. This parameter can range in value from “1” (hardly any adjustable width) to “100” (very large adjustable width).

For Pattern Dithering, the appearance of the Processed Image thumbnail display (to the upper right in Fig. 3.2-1) is very sensitive to the scale factor at which the Processed Image is displayed. This sensitivity results from resampling the Processed Image to fit the display area. To get the most accurate idea of what the processed image really looks like, the scale factor should be one or larger (see Sec. 3.2.2.1 for a brief discussion of scale factors). Also, one can “Proceed” to the Engraving Results window (and then ReProcess if necessary) to achieve a better display of the Processed Image.

3.2.2.4 “Combine Image with Screen and Threshold” Processing Function

The panel corresponding to the “Combine Image with Screen and Threshold” processing function (shortened to Threshold function in the following) is shown in Fig. 3.2-6. This panel can be made visible by Left clicking the “Threshold” function box located near the right-center of the Interactive Process window depicted in Fig. 3.2-1.

Note the functional “flowchart” depicted in the vertical center of Fig. 3.2-1 and note that the outputs from both the “Enhance” and the “Screen” functions serve as inputs to the “Threshold” function. The “Threshold” function linearly combines these two inputs, pixel by pixel, with variable weights, before thresholding the result to create an “Engraver-ready” binary image.
Fig 3.2-6: Combine Image with Screen and Threshold Function

There are two parameters associated with the “Threshold” function: (1) the “Screen %” and (2) the “Output Threshold Level”. The first parameter, the “Screen %”, specifies how the two inputs to the function are combined by specifying the weighting factor assigned to the input from the “Screen” function. The weighting factor assigned to the image coming from the “Enhance” function is then equal to (100 - Screen %). A value of zero for this parameter specifies that the resulting data, before thresholding, is totally from the “Enhance” function. A value of “100” for this parameter specifies that the data, before thresholding, is totally from the “Screen” function. A value of “50” for this parameter specifies that the two inputs are equally weighted and then combined. The “combine” portion of the “Threshold” function is always ON, i.e., the two inputs are ALWAYS combined, before thresholding, using the weighting factors specified by the “Screen %” factor.

The second parameter, the “Output Threshold Level”, specifies a threshold value which ranges from zero to 255. The threshold value is applied to the combined output of the “Enhance” and “Screen” functions, weighted as described above. If a combined value is less than the threshold value, then it is assigned a zero (black). If a combined value is greater than the threshold value, then it is assigned a one (white). The “threshold” portion of this function, unlike the “combine” portion, can be turned ON or OFF by checking, or not checking, the check box located to the left of the label “Output Threshold Level”. If the thresholding is OFF, then the simulation function, described in the next section, cannot be turned ON and an engraver-ready (binary) image is not produced.

Either parameter for this function can be modified by clicking the horizontal scroll bars or by entering a numeric value in the white text boxes immediately below the scroll bars. Clicking the arrow at the ends of the scroll bars changes the parameter value by “1”; clicking within the scroll bar itself changes the parameter value by “10”.

3-16
3.2.2.2.5 "Simulate Engraving" Processing Function

The panel corresponding to the "Simulate Engraving" processing function is shown in Fig. 3.2-7. This panel can be made visible by Left-clicking the "Simulation" function box located near the right-center of the Interactive Process window depicted in Fig. 3.2-1.

![Simulate Engraving Panel](image)

**Fig 3.2-7: Simulate Engraving Function**

The "Simulate Engraving" function provides the capability to simulate the engraving on the selected material and with the processing parameters currently in effect. The "On" check box in the upper right corner of Fig. 3.2-7 indicates that the "Simulate Engraving" function is active if the box is checked; otherwise the function is not active and no simulation occurs regardless of any of the parameter settings. Clicking this check box is equivalent to Right-clicking the "Simulation" function box pictured in the right center of Fig. 3.2-1. If the "On" box is checked, the function box will be green; if it is unchecked, the function box will be white.

The vertical scroll bars labeled "Power" and "Speed" specify the percentage of maximum power and the percentage of the maximum speed for the laser engraver currently being modeled (You can change the laser engraver being modeled as well as the specifications for any laser engraver in the Preferences window - see Sec. 4.1). The "Power" and "Speed" controls should be very similar to the controls which actually exist on your laser engraver and should behave in the same fashion. Clicking the arrows at the ends of the scroll bars will change the appropriate parameter by 1% and clicking within the scroll bar itself will cause a 10% change. You can also enter numeric values in the white text boxes directly below each of the vertical scroll bars.

The text box labeled "DPI", containing the value 250 in Fig. 3.2-7, specifies the Engraver resolution, NOT the image resolution, in dots per inch. This text box is part of a drop-down list and other available resolutions, if any, can be made visible by clicking the down arrow at the right of the box. Clicking any item in the list will cause that item to become the Engraver resolution and will cause the list to collapse with the selected resolution visible in the text box. The text box labeled "Lens", containing the value .003 in Fig. 3.2-7, specifies the effective spot size (diameter in inches) for the Engraver lens. (Some laser engraver manufacturers designate their machines' lenses as "high-resolution", "normal", etc. If the effective spot sizes for your lenses is unknown to you, check the documentation for your laser engraver, or call the manufacturer, to determine the effective spot sizes). Other available lenses, if any, can be made visible and selected in the same manner as the engraver resolution.
The large square box to the right of Fig. 3.2-7, containing 25 dots and with scroll bars on its right and bottom sides, contains graphic representations of the simulated effect of the laser spot on the selected engraving material. Each dot in the 5 x 5 array of dots represents a location where the laser will be positioned for a possible “burn” (the 5 x 5 array could be positioned anywhere within the engraving material - its location is irrelevant). The effect of a “burn” is then represented for the central dot using two different representations.

For the first representation, an elliptical curve is drawn that indicates where the “burning” effect has dropped to half its maximum value (the effect of the laser spot is modeled as a two-dimensional Gaussian curve). Note that in Fig. 3.2-7 there are two curves. On your computer monitor, one of these curves would be blue and the other red. The blue curve represents the laser spot effect when the Interactive Process window was first entered; the red curve represents the current laser spot effect reflecting any changes you might have made that would alter that effect e.g., a change in the engraver lens or a change in lens focus.

The second representation is a two-dimensional representation of the laser spot effect and is visible whenever the “Show Spot” check box, located at the bottom center in Fig. 3.2-7, is checked. For positive polarity materials (positive and negative polarities are discussed below), the effect is represented as a darkening of the white background, i.e., like a “burn” on wood. Figure 3.2-7 shows the representation for a positive polarity material. For negative polarity materials, the effect is represented as a brightening of a black background.

The horizontal and vertical scroll bars, on the bottom and right sides of the square box, control the simulated focus of the laser spot. The horizontal scroll bar specifies the X-Focus (along scan) and the vertical scroll bar specifies the Y-Focus (across scan). The numeric values for the X-Focus and Y-Focus appear in the white text boxes, appropriately labeled, near the center of Fig. 3.2-7. Numeric values can also be entered directly into these text boxes. Values for both the X- and Y-Focus range from -100 to +100 with negative values representing sharper focus and positive values representing a more blurred focus. If the “Focus Synch” check box is checked, then the X- and Y-Focus values are always the same, i.e., any change in one is also made to the other. If the small square with a zero in the lower right corner of Fig. 3.2-7 is clicked, then both X- and Y-Focus values are zeroed. The focus of the laser spot is simulated for the reasons discussed in Sec. 2.2.

The “Polarity” panel, in the upper left corner of Fig. 3.2-7, provides the capability to set the polarity of the Engraved and Simulation images. Positive polarity materials are those for which the laser, when on, causes the engraving material to become darker, e.g., most woods. Negative polarity materials are those for which the laser, when on, causes the engraving material to become lighter, e.g., black laser brass and acrylics. The “Mirror” panel, in the lower left corner of Fig. 3.2-7, provides the capability to “mirror-image” (flip left to right) the Engraved and Simulation images. This feature is useful for materials like acrylic which are recorded on the “back” of the engraving material but viewed from the front. For various reasons, discussed in Sec. 2.2, the processed image is not shown “mirrored” in the Processed Image thumbnail (see Fig. 3.2-1), but rather the Engraved and Simulation images are flipped only when written to disk and/or in the final step of the Text/Resize window.

See Sec. 2.2 for a more complete discussion of the underlying rationale for the simulation capability and how it can be an extraordinarily useful tool.
3.2.3 Menus

The **Menu Bar** contains the following Menu Headings:

```
File   Options   Help
```

Each of these menus is listed and described in the following.

**File Menu**

<table>
<thead>
<tr>
<th>Load Parameters</th>
<th>Last Session's Saved Parameter Sets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Current Parameters</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

The **Load Parameters** menu item causes the same action as the **Load Params** command button described in Sec. 3.2.2.1 except that it also allows you to load those parameters in effect when PhotoGrav terminated its previous session (**Last Session's**).

The **Save Current Parameters** menu item causes the same action as the **Save Params** command button described in Sec 3.2.2.1.

The "Exit" item causes the same action as clicking the **Exit** command button described in Sec. 3.2.2.1.

**Options Menu**

- Synchronized L/R Displays
- Display Big Images
- Proceed with Engraving
- Restore Processing Parameters
The Synchronized L/R Displays menu item behaves in the same way as the Synchronized check box described in Sec. 3.2.2.1. A check mark beside this item indicates that the Left and Right thumbnail displays are synchronized. The absence of a check mark indicates that they are not synchronized.

The Display Big Images menu item behaves in the same way as the Big Images check box described in Sec 3.2.2.1. A check mark beside this item indicates that the larger size thumbnails are displayed. The absence of a check mark indicates that the smaller size thumbnails are displayed.

The Proceed with Engraving menu item causes the same action as the Proceed command button described in Sec. 3.2.2.1.

The Restore Processing Parameters menu item causes the same action as the Restore command button described in Sec. 3.2.2.1.

Help Menu

The Help Menu for the Interactive Process window is nearly identical to the Help Menu for all other windows and is described in Section 3.1.3

3.2.4 Status Bar

The Status Bar consists of four panels and is nearly identical to the Status Bar described in Section 3.1.4. The only difference is that the second panel from the left always specifies the engraving material (followed by a hyphen and a Named Parameter Set name if any is active) and will NOT toggle if clicked to display the laser engraver name and the settings for the engraver.
3.3 Engraving Results Window

3.3.1 Functions

This window (see Fig. 3.3-1) displays the results of PhotoGrav’s processing functions in a manner that facilitates comparisons to the original input image. The input image, the engraved image, and the simulation image are all displayed, one at a time, within this window. The images can be successively and rapidly displayed by clicking a “Cycle Images” command button. Also, the images can be enlarged in a variety of ways to further enhance the comparison capabilities.

From this window, the engraved image can be saved to disk for later transfer to the laser engraver and reports can be generated that completely describe the PhotoGrav session. If desired, one can proceed from this window to the Text/Resize window to add captions to the engraving or to resize the “canvas” on which the engraved image resides. One can also “Reprocess” the image whereby control is transferred to the Interactive Process window for adjustments to the processing parameters.

Fig. 3.3-1: Engraving Results Window
3.3.2 Controls

**TaskBar Command Buttons** (from left to right across the TaskBar)

**ReProcess**
This command invokes the **Interactive Process** window to allow "tweaking" of the process parameters and creation of new Engraved and Simulation images. The existing Engraved and Simulation images should be saved, if desired, before selecting this command.

**Info**
Displays all available information about the input image, engraving material, processing parameters, and the Laser Engraver parameters currently being modeled by PhotoGrav. The information can be printed by choosing the **Print Report** button that appears on the information display or by choosing the **Print Information** item on the **File** menu.

**Cycle Images**
This command button, when clicked, cycles the display among the Original, the Engraved, and the Simulation images. Using the Left mouse button cycles in one direction (Original → Engraved → Simulation) and the Right mouse button cycles in the opposite direction. Thus, one can cycle back and forth between any two images by alternately using the Left & Right buttons. The Original, the Engraved, and the Simulation images are all in registration, even when magnified, to facilitate comparisons.

**Save Simulation**
Saves on disk whichever of the three images (Original, Engraved, or Simulation) is currently displayed. You can also use the **Save** commands located on the **File** menu to save the images.

**Print Simulation**
Prints whichever of the three images (Original, Engraved, or Simulation) is currently displayed. You can also use the **Print** commands located on the **File** menu to print the images.

**Save Params**
Saves the current processing parameters, including the engraving material, as a Named Parameter Set on disk. The current processing parameters are those that were used to create the Engraved & Simulation images displayed in this window. Named Parameter Sets can subsequently be used to process other images that you want to engrave on the current engraving material under the same conditions as those currently in effect.

**Text/Resize**
This command invokes the **Text/Resize** window which provides the capability to add text to and to resize the Engraved and Simulation images. If you want to save these images in their current form (i.e. without text and at their current size) then you should save them to disk before choosing this command.
New Image

This command invokes the **Input Selection** window which allows you to select a new image, a different engraving material, and/or a different **Named Parameter Set**. You will be asked if you want to save the Engraved and/or Simulation image, if you have not already done so, before leaving this window. However, no check is made if the “**Minimize Cautionary Messages**” checkbox is checked in the **Preferences** window.

? 

Provides context-sensitive Help for any enabled control. Left clicking the “?” causes the cursor to change into a “?” cursor. Position the “?” cursor on a control about which you want information, click, and a dialog box appears with the information. When finished reading the information, click the dialog box to make it disappear.

Exit 

Exits the PhotoGrav program after checking whether or not you want to save the Engraved and/or Simulation images if you have not already done so. However, no check is made if the “**Minimize Cautionary Messages**” checkbox is checked in the **Preferences** window.

3.3.3 Menus

The **Menu Bar** for the **Engraving Results** window contains the following Menu Headings:

<table>
<thead>
<tr>
<th>File</th>
<th>Options</th>
<th>View</th>
<th>Help</th>
</tr>
</thead>
</table>

Each of these menus is listed and described in the following.
The first section from the top in the **File Menu** provides the capability to save the Original, the Engraved, or the Simulation image. Clicking any of the three choices causes the appropriate image to be displayed and then invokes the standard Windows dialog box for saving files.

The **Save Params** menu item causes the same action as the **Save Params** command button on the **TaskBar**.

The third section from the top in the **File Menu** provides the capability to print the Original, the Engraved, or the Simulation image. The images can be printed at actual size or at a size to "fill the page". A caption, printed underneath the image, specifies the type of the printed image (Original, Engraved, or Simulation), specifies the image name (if saved to disk), and specifies the current date and time.

The "**Print Information**" item will print the same information that can be displayed by clicking the **Info** command button (the displayed information form also contains a "Print" button which can be used to send the displayed information to the printer).

The "**Exit**" item causes the same action as clicking the **Exit** command button on the **TaskBar**.
These Options Menu items perform the same actions as the similarly-named TaskBar command buttons.

View Menu

<table>
<thead>
<tr>
<th>Original Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engraved Image</td>
</tr>
<tr>
<td>✔ Simulation Image</td>
</tr>
<tr>
<td>Show Processing Information</td>
</tr>
<tr>
<td>Hide Tool Bar</td>
</tr>
</tbody>
</table>

Clicking an item in the first section from the top in the View Menu causes the appropriate image to be displayed. A check mark beside an item specifies which of the three images is currently displayed.

The “Show Processing Information” item performs the same action as the Info command button on the TaskBar. The “Hide Tool Bar” item causes the Tool Bar (also called the TaskBar) to be hidden. The image display, if any, becomes correspondingly larger when the TaskBar is hidden and the menu item becomes “Show Tool Bar”.

Help Menu

The Help Menu for the Engraving Results window is nearly identical to the Help Menu for all other windows and is described in Section 3.1.3

3.3.4 Status Bar

The Status Bar consists of four panels and is nearly identical to the Status Bar described in Section 3.1.4. The one difference is that the first panel from the left specifies which of the three image types (Original, Engraved, or Simulation) is currently displayed rather than the name and complete path of the input image. The name and path of the input image can be viewed by clicking the Info command button on the TaskBar.
3.4 Text/Resize Window

3.4.1 Functions

This window (see Fig. 3.4-1) initially displays the entire Simulation Image and provides the capability to resize and add text to this image. Any such operations that are performed on the Simulation Image are ALSO PERFORMED on the Engraved Image although that image is not initially displayed.

You can add any number of text captions to the Simulation Image using any of the fonts available on your computer. In this window you can also “crop” the Simulation Image or enlarge the area of the material on which the engraved photo is to reside. The photo can then be positioned anywhere on the resized area. Remember that any operations that are performed on the Simulation Image are also implicitly being performed on the Engraved Image.

![Text/Resize Window](image)

Fig. 3.4-1: Text/Resize Window
3.4.2 Controls

TaskBar Command Buttons (from left to right across the TaskBar)

Resize
This command button causes the display of a panel (see Fig. 3.4-2) which presents a set of options for resizing the Simulation Image. Resizing can consist of: (1) "Cropping" the processed images to remove unwanted portions OR (2) Enlargement of the "canvas" on which the processed images reside.

Orig. Size
This command button restores the Simulation Image to its original size. Any text that has been added to the images is retained but might not be positioned as desired. This button is disabled (grayed) if no resizing operation has been performed.

Add Text
This command button causes the display of a Caption Window (see Fig. 3.4-4) which provides the capability to enter a multiline text caption and to select the font, size, and style of that caption. The caption is then displayed on the Simulation Image as it would appear after engraving. Any number of captions can be added to the Simulation Image.

Finished
This command button signals PhotoGrav that you are finished adding text or resizing the Simulation Image. After choosing this command, the Engraved Image is displayed in exactly the format in which it would be sent to the laser engraver, i.e., in the correct polarity and either mirrored or not depending on your previous choices and/or on the automatic parameters supplied by PhotoGrav. At this point you have the opportunity to save the processed images to disk or to print them.

New Image
This command invokes the Input Selection window which allows you to select a new image, a different engraving material, and/or a different Named Parameter Set. You will be asked if you want to save the Engraved and/or Simulation image, if you have not already done so, before leaving this window. However, no check is made if the "Minimize Cautionary Messages" check box is checked in the Preferences window.

? Provides context-sensitive Help for any enabled control. Left clicking the "?" causes the cursor to change into a "?". Position the "?", cursor on a control about which you want information, click, and a dialog box appears with the information. When finished reading the information, click the dialog box to make it disappear.
Exit

Exits the PhotoGrav program after checking whether or not you want to save the Engraved and/or Simulation images if you have not already done so. However, no check is made if the “Minimize Cautionary Messages” checkbox is checked in the Preferences window.

The TaskBar command buttons described above are those that appear when the Text/Resize window is initially displayed. Also, Fig. 3.4-1 presents the initial appearance of the Text/Resize window before any commands have been invoked or any operations performed. When certain commands are invoked, other panels and/or windows are often displayed to support the specified operation and the command buttons visible and active in the TaskBar might change to support the specified operation or to provide a new set of options. Changes to the Text/Resize window (Fig. 3.4-1) and changes to the TaskBar as commands are invoked are presented and described in the following.

Changes Caused by Clicking the “Resize” Command Button

Clicking Resize causes the the “Plaque Size” panel to be displayed in the Text/Resize window (Fig. 3.4-2). This panel presents several methods for “resizing” the Simulation Image.

![Fig. 3.4-2: “Plaque Size” Panel (Invoked by “Resize” button)](image_url)
The top two frames in the "Plaque Size" panel are informational only and present the "Original Size" and the "Current Size" of the Simulation Image. The "Current Size" is the size if any previous resizing operations have been performed. For the case in Fig. 3.4-2, no previous resizes were done so the original and current sizes are the same. The "New Size" frame provides the capability for you to change the size of the "canvas" on which the Simulation Image resides by entering numeric values in the white text boxes. The new size can be specified in inches or in pixels and can be an enlargement or "cropping" of the original size. The new size can also be specified by clicking one of the options in the "Standard Plaque Sizes" panel to the left of the "New Size" frame. Clicking an option causes the appropriate values to be entered into the white text boxes in the "New Size" frame. For the example in Fig. 3.4-2, the new size has been specified as 4.00" x 4.00". It is important to note that the size and scale of the digitized photograph is NOT changed by this operation. Rather, just the "canvas" or background on which the photograph resides is being changed (enlarged or "cropped").

There are two options available for how the Simulation Image is positioned on the newly-sized canvas: (1) FreeForm Positioning and (2) Grid Positioning. If the "FreeForm Positioning" option is chosen, then the "Placement" box (located to the lower left of the panel in Fig. 3.4-2) is not visible and one is allowed, after the "OK" button is clicked, to "click and drag" to position the Simulation Image anywhere within the newly-sized canvas (see Fig. 3.4-3). If the "Grid Positioning" option is chosen, then the "Placement" box is used to position the Simulation Image in one of the nine grid positions provided by the "Placement" box. A grid position is selected by clicking on one of the nine grid positions which becomes darker indicating its selection. After clicking the "OK" button, the Simulated Image is then positioned appropriately and displayed.

The "Show Bevel Width" check box provides the capability for a bevel of user-specified width to be displayed on the Simulation Image. This capability is intended to aid in the placement of the Simulation Image on the newly-sized canvas and also to assist in placing text captions on a beveled plaque. The lines which indicate the bevel occur ONLY on the Simulation Image; they do NOT occur on the corresponding Engraved Image (the image to be sent to the Laser Engraver).

The "Fill Color for New Areas" frame provides two options for "filling" areas when the newly-sized canvas is larger than the original Simulation Image. The left-hand option (lighter-colored box in Fig. 3.4-2) will fill areas with a color corresponding to the "unburned" (laser off) engraving material. The right-hand option (darker-colored box in Fig. 3.4-2) will fill areas with a color corresponding to the "burned" (laser on) engraving material. For positive-polarity materials ("burned" is darker than "unburned"), the "filled" background is generally indistinguishable from the background of the original Simulation Image. For negative-polarity materials ("burned" is lighter than "unburned"), there is usually a slight color difference between "filled" background and "original" background due to "incomplete burnoff" in generating the Simulation Image.

Clicking the "Cancel" command button causes the "Plaque Size" panel to disappear and the Text/Resize window to be restored to the appearance and status it had before the Resize command button was clicked. Clicking the "OK" command button also causes the "Plaque Size" panel to disappear and then causes one of two actions depending on whether the "FreeForm Positioning" or "Grid Positioning" option had been selected. If the "Grid Positioning" option had been selected, then the Simulation Image is automatically positioned on the newly-sized canvas and the result displayed in the Text/Resize window as depicted in Fig. 3.4-1 with the newly-sized image replacing the original Simulation Image. If the "FreeForm Positioning" option had been chosen, then the Text/Resize
window appears as pictured in Fig. 3.4-3 in preparation for your positioning of the Simulation Image on the newly-sized canvas.

Fig. 3.4-3: “FreeForm Positioning” of Resized Simulation Image

The dark gray area in Fig. 3.4-3 represents the area of the newly-sized “canvas” (On your computer monitor, this area is represented by a light shade of green). The bevel indicators, if any, are the black lines as depicted in Fig. 3.4-3. The original-sized Simulation Image is positioned as indicated (represented by the white area in Fig. 3.4-3 but on your monitor this area would be the actual Simulation Image). By “clicking and dragging” the Simulation Image, you can position it just about anywhere relative to the green rectangle (dark gray in Fig. 3.4-3) including positions that lie mostly outside of the green rectangle. The cursor must lie within the green rectangle when you release the mouse button to terminate the "click and drag" operation. Otherwise, a popup Help window appears and the Simulation Image is not moved. The “Horizontal” and “Vertical” command buttons near the left bottom of the window cause the Simulation image to be centered relative to the green rectangle.
Clicking the "Cancel" command button causes the "FreeForm Positioning" objects in Fig. 3.4-3 to disappear and the Text/Resize window to be restored to the appearance and status it had before the Resize command button was clicked. In other words, clicking the "Cancel" button pictured in Fig. 3.4-3 has the same effect as clicking the "Cancel" button depicted in Fig. 3.4-2. Clicking the "OK" command button causes the "FreeForm Positioning" objects to disappear, positions the Simulation Image on the newly-sized canvas as specified, and displays the result in the Text/Resize window as depicted in Fig. 3.4-1 with the newly-sized image replacing the original Simulation Image.

There are no changes to the TaskBar command buttons as a result of the sizing operations discussed in the last several pages except that the "Orig. Size" command button is now enabled unless either of the "Cancel" command buttons in Figs. 3.4-2 or 3.4-3 was chosen.

Changes Caused by Clicking the "Add Text" Command Button

Clicking Add Text causes the the Caption window (Fig. 3.4-4) to be displayed on top of the Text/Resize window. This window provides the capability for specifying multi-line text captions to be superimposed on the Simulation Image.

![Image of Caption Window](image)

**Fig. 3.4-4: "Caption" Window**
The “Font”, “Font Style”, and “Size” lists are used in the usual way to specify the desired font name, style, and size. Font name and font style choices can only be selected from the lists. The font size, however, can be directly entered into the text box directly below the title “Size:”. The font size is limited to the range (6 to 512) although certain fonts may not work for all values in this range. The “Text Justification” frame provides the capability to left-, center-, or right-justify multiline text caption lines relative to each other (NOT relative to the Simulation Image upon which the caption will ultimately be superimposed).

The “Text Color” frame provides two options for the “color” of the text. The top option (lighter-colored box in Fig. 3.4-4) will create text with a “color” corresponding to the “unburned” (laser off) engraving material. The bottom option (darker-colored box in Fig. 3.4-4) will create text with a “color” corresponding to the “burned” (laser on) engraving material. As an example, for most woods, one would use the bottom option so that the text character would be “burned” into the otherwise unburned wood. However, there might be cases where one would want characters visible in an area that was otherwise heavily burned. The top option could then be used to ensure that the text characters would not be burned and would thus be visible when surrounded by the “burned” background. If in doubt, try one of the options and see how it looks on the Simulation Image. Remember that the Simulation Image is a WYSIWYE (What You See Is What You Engrave) object and one of its most powerful features is the removal of doubt about what polarity to use for engraving - for both images and text!

The white text box titled “Enter Caption Below:” is where you actually type in the multiline text caption. Click in the box and start typing your caption. Use the “Enter” keyboard key for the end of a line and the start of a new line. As you type, the caption also appears in the gray text box titled “Caption Appearance on Plaque” in the format and size that you have specified.

Clicking the “Cancel” command button will cause the Caption window to disappear and the Text/Resize window to be restored to the appearance and status it had before the Add Text command button was clicked. Clicking the “OK” command button will cause the Caption window to disappear and the Simulation Image to be displayed in the Text/Resize window with the caption superimposed on the image in a bright blue color. The bright blue color indicates that this caption is the “active” caption. Clicking elsewhere on the Simulation Image, away from the caption, will deactivate the caption and it will then be displayed in the “color” you specified.

When a caption is “active”, the TaskBar has several additional controls as depicted in Fig. 3.4-5:

![TaskBar when a Text Caption is active](image)

The horizontal and vertical arrows can be used to center the active caption horizontally and vertically, respectively, relative to the Simulation Image. The “Delete” command button can be used to delete the active caption.
Any existing caption can be made active by Left-clicking on the caption. An active caption can be positioned anywhere on (or partially off) the Simulation Image by “clicking and dragging” the caption to the desired location. A caption can be edited by Right-clicking on the caption which causes the Caption window to appear with the text and its properties all set appropriately, ready for modification. Left-clicking a caption while simultaneously pressing the Ctrl key, the Alt key, or the Shift key will delete the caption.

Changes Caused by Clicking the “Finished” Command Button

When all desired resizing and text operations are complete, the Finished command button on the TaskBar should be clicked. This causes the Engraved Image to be displayed in the “correct polarity”, i.e., black (zeros) indicate laser ON and white (ones) indicate laser OFF. The Simulated Image is also available for display but the Engraved Image is displayed first.

If the “Mirror” flag is ON for the image, indicating that the image should be flipped Left to Right before being sent to the engraver (e.g., for an acrylic engraving), then you will be informed that the “Mirror” flag is ON and will be asked the following question: “Do you want the Engraved Image flipped in the following display?” If you answer “Yes”, then the Engraved Image will be displayed exactly as it would normally be stored on disk for eventual transfer to the laser engraver but comparisons to the Simulated Image will be difficult (the Simulated Image is NOT flipped Left to Right). If you answer “No”, then the Engraved Image is not flipped, for display purposes, and comparisons to the Simulated Image will be easier. In either case (whether you answer “Yes” or “No” to the question), if the image is later saved to disk and the “Mirror” flag is ON, then a similar question will be asked about whether or not you want the Engraved Image flipped before being saved to disk. Normally, you should answer “Yes” to this question.

There is one further complication to the above. If, in the Preferences window, you have checked the box for Minimize Cautionary Messages, then you will NOT be asked the question whether or not you “want the Engraved Image flipped in the following display?” In this case, the image will be displayed NOT FLIPPED but WILL be flipped when and if it is written to disk.

Clicking the Finished command button also causes changes to the TaskBar as indicated in Fig. 3.4-6.

Fig. 3.4-6: TaskBar after clicking “Finished”

The “Save Simulation” and “Save Engraved” command buttons initiate a standard Windows dialog box to save the respective images to disk. Similarly, the “Save Params” command button initiates a dialog box to save the current processing parameters, including the engraving material, as a Named
Parameter Set on disk. The “Display Engraved” command button is a toggle button which allows you to switch the display rapidly back and forth between the Engraved and Simulation Images. When the displayed image is the Simulation Image, then the caption on the button will be “Display Engraved” as depicted in Fig. 3.4-6. However, when the displayed image is the Engraved Image, then the caption on the button will be “Display Simulation”. The “Print Simulation” and “Print Engraved” command buttons invoke dialog boxes that allow you to choose a printer, if you have more than one, set the printer parameters, specify the size of the printed image, and print the respective images.

3.4.3 Menus

The Menu Bar for the Text/Resize window contains the following Menu Headings:

```
File   Tools   View   Help
```

Each of these menus is listed and described in the following. Some of the menu items are disabled until certain events occur, e.g., clicking the “Finished” command button.

File Menu

<table>
<thead>
<tr>
<th>Save Simulation Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Engraved Image</td>
</tr>
<tr>
<td>Save Parameter Set</td>
</tr>
<tr>
<td>Print Simulation Image</td>
</tr>
<tr>
<td>Print Engraved Image</td>
</tr>
<tr>
<td>Restart - New Image</td>
</tr>
<tr>
<td>Exit</td>
</tr>
</tbody>
</table>

The first section from the top in the File Menu provides the capability to save the Simulation or the Engraved image. Clicking either of the two choices causes the appropriate image to be displayed and then invokes the standard Windows dialog box for saving files.

The “Save Parameter Set” item initiates a dialog box to save the current processing parameters, including the engraving material, as a Named Parameter Set on disk.

The third section from the top in the File Menu provides the capability to print the Simulation
or the Engraved image. The images can be printed at actual size or at a size to “fill the page”. A caption, printed underneath the image, specifies the type of the printed image (Simulation or Engraved), specifies the image name (if saved to disk), and specifies the current date and time.

The “Restart - New Image” item causes the same action as the New Image command button on the TaskBar as described at the start of Sec. 3.4.2.

The “Exit” item causes the same action as clicking the Exit command button on the TaskBar as described at the start of Sec. 3.4.2.

Tools Menu

<table>
<thead>
<tr>
<th>Resize</th>
<th>Original Size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add Text to Plaque</td>
</tr>
<tr>
<td></td>
<td>Center Text Horiz.</td>
</tr>
<tr>
<td></td>
<td>Center Text Vert.</td>
</tr>
<tr>
<td></td>
<td>Delete Text</td>
</tr>
<tr>
<td></td>
<td>Plaque Finished</td>
</tr>
</tbody>
</table>

The “Resize” item causes the same action as the Resize command button on the TaskBar as described at the start of Sec. 3.4.2.

The “Original Size” item causes the same action as clicking the Orig. Size command button on the TaskBar as described at the start of Sec. 3.4.2.

The “Add Text to Plaque” item causes the same action as the Add Text command button on the TaskBar as described at the start of Sec. 3.4.2.

The “Center Text Horiz.”, “Center Text Vert.”, and ”Delete Text" items are enabled only when a text caption is active and are used to center the active caption horizontally and vertically, respectively, relative to the Simulation Image or to delete the currently-active caption.

The “Plaque Finished” item causes the same action as clicking the Finished command button on the TaskBar as described at the start of Sec. 3.4.2.
View Menu

- Engraved Image
- Simulation Image
- Hide Tool Bar

The "Engraved Image" and "Simulation Image" items are only visible after the Finished command button has been clicked (or the "Plaque Finished" item on the "Tools" menu has been selected). Selecting either of these items displays the appropriate image. A check mark indicates which image is currently displayed.

The “Hide Tool Bar” item causes the Tool Bar (also called the TaskBar) to be hidden. Unlike for other windows, the image display does not become larger when the TaskBar is hidden. When the TaskBar is hidden, the menu item becomes "Show Tool Bar”.

Help Menu

The Help Menu for the Engraving Results window is nearly identical to the Help Menu for all other windows and is described in Section 3.1.3

3.4.4 Status Bar

The Status Bar consists of four panels. The first panel from the left contains the name and complete path of the input image. The second panel from the left toggles between: (1) the engraving material (followed by a hyphen and a Named Parameter Set name if any is active) and (2) the laser engraver name and the settings for the engraver. Clicking the panel will cause it to alternately display one of these two items. The last two panels contain the current date and time, respectively.
4.0 Introduction

This chapter describes PhotoGrav's support windows which provide a variety of functions to support the smooth flow of events within a PhotoGrav session. Generally, the support windows are invoked from one or more of PhotoGrav's primary windows as depicted in Fig. 4.0-1.

![Diagram showing the relationship of Primary/Support Windows]

**Fig. 4.0-1: Relationship of Primary/Support Windows**

The Preferences support window can only be invoked from the Input Selection window and is used to select and modify the laser engraver and associated parameters which PhotoGrav is currently modeling. This support window also provides for modifying several options which control the behavior of some of PhotoGrav's operational characteristics. The Modify Material support window
can also only be invoked from the **Input Selection** window and provides for the selection of an engraving material and the capability to modify its appearance (brightness, contrast, and color). The **DPI Specification** window is another support window that can only be invoked from the **Input Selection** window. This support window provides the capability to change the dpi (dots per inch) associated with the current input image. This window is automatically invoked if an Original (input) Image has an invalid dpi or you can invoke it to temporarily change the dpi associated with any Original Image.

The **Info Report** support window can be invoked from either the **Input Selection** or the **Engraving Results** window. This support window displays all available information about the input image, the engraving material, the processing parameters, and the Laser Engraver parameters currently being modeled by PhotoGrav. It also displays processing results if invoked from the **Engraving Results** window. The **Print** support window can be invoked from the **Engraving Results** or Text/Resize windows. This support window lets you choose whether to print images at actual size or at a size scaled to the size of your paper.

This chapter, Chapter Four, provides a detailed description of each of these support windows. The description includes: (1) An overview schematic of each window with labels specifying the major components of the window, (2) a brief description of the main functions of the window, (3) a detailed description of the controls that reside within the window, (4) a description of the menu items for the window (if any), and (5) the contents of the Status Bar for this window (if any). Only the **Modify Material** support window has menu items and a Status Bar.

The name of each support window occurs to the left in the window’s Title Bar.
4.1 Preferences Window

4.1.1 Functions

The Preferences window (see Fig. 4.1-1) can only be invoked from the Input Selection window and is used to select and modify the laser engraver and associated parameters which PhotoGrav is currently modeling. This support window also provides for modifying several options which control the behavior of some of PhotoGrav's operational characteristics. The "Machine Model" frame in Fig. 4.1-1 provides the capability for you to select your laser engraver model. The "Machine Properties" frame provides the capability for you to modify, add to, or specify completely, the parameters that essentially define the laser engraver model. The "PhotoGrav Options" frame in Fig. 4.1-1 provides the capability for you to specify various options that control certain aspects of PhotoGrav's operational behavior.

![Preferences Window](image)

**Fig. 4.1-1: "Preferences" Support Window**
4.1.2 Controls

4.1.2.1 "Machine Model" Controls

The list at the top of the "Machine Model" frame displays the laser engraver machines currently modeled by PhotoGrav including a "User Defined" machine for which you can completely specify the engraver parameters from scratch. Selecting a machine from the list will enter the machine's name into the text box immediately below the list. Clicking the "Load" command button will then insert the current parameters for that machine into the appropriate lists and text boxes in the "Machine Properties" frame to the right of Fig. 4.1-1. Double-clicking an item (machine) in the list is equivalent to single-clicking the item and then clicking the "Load" command button.

Clicking the "Restore Default" command button will restore a machine's parameters, to the values they had when PhotoGrav was first installed, for whatever machine's name is in the text box immediately above the command buttons. (Any machine's parameters can be modified using the controls in the "Machine Properties" frame and the modified parameters become the current parameters for the machine and are stored to disk as such when the current PhotoGrav session terminates).

4.1.2.2 "Machine Properties" Controls

The first two text boxes at the top of the "Machine Properties" frame specify the maximum power (in watts) and the maximum speed (in inches/second) for the current laser engraver. These two values obviously have a big influence on how PhotoGrav produces the Simulation Image. The third text box from the top specifies the time, in seconds, for the laser to slow down, stop, and reverse direction for each scan line. This parameter is used only for calculating estimates of the engraving time, which are displayed in the PhotoGrav Information Reports (see Sec. 4.4) A procedure for calculating this parameter for your particular machine is presented in Appendix 3: Calculational Procedure for "Turn Time".

The list to the left of the "Lens Spot Sizes" frame contains a list of the effective laser spot sizes (diameters in inches) for the lenses available to the simulated Laser Engraver. These are the values that are available to PhotoGrav for creating the Simulation Image. A single click of an item in the list enters the selected value into the "inches" text box and also into the "Always Use" text box. Numeric values can also be entered directly in either text box by clicking in the box and typing in the numeric value. Values in the "inches" textbox can be Added to or Deleted from the Lenses list by clicking the "Add" or "Delete" command button, respectively. The "Always Use" text box contains a value for the lens spot size which will always be used in simulations, if the "Always Use" check box is checked, unless explicitly changed in the Interactive Process window. If there is no entry in this text box, or if the entry is zero, then PhotoGrav will use the spot size from the list that is closest in value to the size specified for the current engraving material. Regardless of what spot size is used, PhotoGrav adjusts itself appropriately so that the simulated engraving is as realistic as possible. Generally, for photographs, the spot size corresponding to the high-resolution lens should probably be specified in this text box if that lens is available on your machine. Values can be deleted from the "Always Use" check box by highlighting the value and then pressing the delete key on the keyboard (the "Delete" command button only deletes values from the lenses list).
The list to the left of the “Machine Resolutions” frame contains a list of the resolutions (dots per inch) available to the simulated Laser Engraver. The controls in this frame behave identically to the controls in the “Lens Spot Sizes” frame as described in the preceding paragraph. However, when adding resolutions (dpi’s) to the dpi’s list, a check is made to see if the newly added dpi value is an integer factor of the largest dpi value currently in the list. If not, a warning is issued but that warning can be ignored with no harm done. The reason for the warning is that, for most laser engravers, all the available resolutions are integer factors of the largest dpi value (finest resolution) for the engraver. A warning will also be issued if the largest dpi value is not entered first but that warning can also be ignored.

4.1.2.3 “PhotoGrav Options” Controls

The “PhotoGrav Options” frame contains several check boxes which control the behavior of some of PhotoGrav’s operational characteristics. The “Simulated Engravings” check box determines whether or not PhotoGrav produces Simulation Images when processing an Original Image. If this box is checked, then Simulation Images are produced; if not checked, then no Simulation Images are produced. Engraved Images (the binary images that should be sent to your laser engraver) are always produced. If Simulation Images are not to be produced (unchecked box), then PhotoGrav’s execution times will be smaller but one might have less confidence about the eventual appearance of the actual engraving. Also, if Simulated Engravings are not produced, then the Text/Resize window cannot be invoked, i.e., no text captions can be added to the engraving nor can the “canvas” for the engraved image be resized.

The “Estimates of Engraving Times” check box determines whether or not PhotoGrav will estimate the time for your laser engraver to actually engrave the image. If checked, estimates are made; if not checked, no estimates are calculated. If you have no use for the estimates, then some PhotoGrav execution time can be saved by ensuring that this box is unchecked.

The “Maximize Power” and “Maximize Speed” check boxes determine whether the Power setting or Speed setting for your machine is maximized when it is necessary to modify these settings. The necessity for modifying settings occurs since PhotoGrav’s engraving materials were calibrated using a specific machine and the power, speed, resolution, etc. of your machine may not match those of the “calibration” machine. PhotoGrav strives to deliver the appropriate quantity of energy to each laser spot, based on the settings for your machine, and in so doing has a choice of what values to use for the Power and Speed settings (generally a large number of settings will all satisfy the energy requirement). If you are interested in engraving as fast as possible, then the “Maximize Speed” box should be checked. If you are more comfortable with a higher power setting, then the “Maximize Power” box should be checked. These two boxes cannot both be checked or unchecked at the same time so the boxes also act as toggles, i.e., if you check the “Maximize Power” box, then the “Maximize Speed” box will automatically become unchecked and vice versa. (Note: The effect of these check boxes may at times appear confusing and it may at first appear to you that they are not working properly. It is important to remember that “Maximize” is used for both boxes to mean the maximum value for that parameter that will still result in the proper energy being delivered to the laser spot and that maximum value may not be 100%. For example, if the “Maximize Speed” box is checked, then it would be possible for the Power and Speed settings to be, e.g., 100% and 65%, respectively, which might at first seem incorrect since “Speed” was to have been maximized. However, in the example given, if the Speed is more than 65%, then inadequate energy will be delivered to the laser spot since the Power setting cannot be more than 100% (Speeding the engraver...
up delivers less energy to each spot). So, in this case, 65% is indeed the “maximum” value for the Speed setting subject to the constraint that the proper quantity of energy is delivered to the laser spot.

If the “Minimize Cautionary Messages” box is checked, then the number of PhotoGrav cautionary messages which are displayed is minimized. Specifically, the following types of messages are NOT displayed:

1. Messages that check if you are sure you want to exit PhotoGrav.
2. Messages that check if you want to save processed images, if any have been created, before exiting PhotoGrav or before opening a new image.
3. Messages that check if you want to "Flip Left to Right" images to be engraved when the "Mirror" flag is ON. (If cautionary messages are not displayed, then “Mirrored” images are displayed NOT FLIPPED but are saved to disk FLIPPED).

Although checking this box can streamline PhotoGrav's execution, caution should be exercised so that one does not inadvertently Exit the program without saving processed images.

Clicking the “Cancel” command button will cause the Preferences window to disappear and all of the parameter and option settings that exist within that window to be restored to the values they had upon entry to the Preferences window. Clicking the “OK” command button will cause the Preferences window to disappear and will cause any changes to the parameter and option settings to become effective.
4.2 Modify Material Window

4.2.1 Functions

The Modify Material window (see Fig. 4.2-1) can only be invoked from the Input Selection window and provides the capability to both select and modify the appearance of an engraving material. The capability to modify the engraving material’s appearance enhances PhotoGrav’s usefulness in two ways. The more important of the two ways is that it allows a broad range of solid-color plastics to be effectively modeled by PhotoGrav. This is achieved by providing two materials both of which have a User-Defined Cap but one of which has a white core and the other has a black core (see the list of Plastics in Fig. 4.2-1). These user-defined caps can be modified to have any solid color as will be described in Sec. 4.2.2. The other way that the capability to modify the engraving material’s appearance can be useful results from the fact that many engraving materials, although similar to those provided by PhotoGrav, might differ somewhat in color and brightness. The capability to alter their appearance might improve the fidelity of the simulated engravings produced by PhotoGrav.

Fig. 4.2-1: “Modify Material” Window - Initial Appearance
The material to be modified can be chosen by clicking an item in the list in Fig. 4.2-1 and then clicking the "OK" command button. The material can also be chosen by double-clicking an item in the list. In either case, choosing a material causes the list of engraving materials to disappear and the **Modify Material** window to assume the appearance depicted in Fig. 4.2-2.

![Modify Material Window - Scratch Disk Free Space: 292.8 MB](image)

**Fig. 4.2-2:** "Modify Material" Window - After Material Selection

### 4.2.2 Controls

The large white square to the left of Fig. 4.2-2 represents the appearance of the chosen engraving material before any modifications have been performed. The smaller dark-gray square to the upper right of Fig. 4.2-2 represents the appearance of the material after modification.

The controls in the "Color Adjustments" frame are used to modify the appearance of the engraving material. The "Brightness" and "Contrast" controls affect the overall brightness and contrast of the material for all colors equally. The "Brightness" modification can range from -100 to +100 and the
“Contrast” modification can range from -1.00 to +1.00. The modification values can be changed only by clicking the scroll bars, not by direct numerical entries in the text boxes. Clicking on a scroll bar’s arrow changes its value by 1% (of the parameter’s maximum value) and clicking within a scroll bar itself changes its value by 10%.

The “Red Tint”, “Green Tint”, and “Blue Tint” scroll bars change the contrast of the respective colors. The tint modifications can range from -1.00 to +1.00 and can be changed only by clicking the scroll bars, not by direct numerical entries in the text boxes. Clicking on a scroll bar’s arrow changes its value by 1% (of the tint’s maximum value) and clicking within a scroll bar itself changes its value by 10%.

Modifications caused by the adjustments are immediately visible in the smaller dark-gray square to the upper right of Fig. 4.2-2. The “Reset” command button resets all of the scroll bars to the “no adjustment” state, i.e., all zeroes.

Consider Fig. 4.2-2 and note that the material is: User-Defined Cap/White Core. Note also that the “Green Tint” and “Blue Tint” have values of -1.00. The effect of these values is that, on your computer monitor, the small dark-gray square in the upper right of Fig. 4.2-2 would be a bright red color. That red color could be further adjusted by changes in the “Brightness”, “Contrast”, and “Red Tint” scroll bars. The net result is that one can create almost any desired color for the cap of a solid-color plastic for which the core color can be either white (in the example) or black.

TaskBar Command Buttons (from left to right across the TaskBar)

Reselect Material
This command button provides the opportunity to re-select the engraving material if you change your mind. The Modify Material window resumes the appearance it had in Fig. 4.2-1.

Interactive Process
This command button causes the Modify Material window to disappear and causes PhotoGrav to proceed to the Interactive Process window where you can interactively adjust the processing parameters and see the effect in real time.

Auto Process
This command button causes the Modify Material window to disappear and causes PhotoGrav to process the image with currently existing parameters and to display the Original, Engraved, and Simulation images for comparison in the Engraving Results window.

? Provides context-sensitive Help for any enabled control. Left clicking the “?” causes the cursor to change into a “?” . Position the “?” cursor on a control about which you want information, click, and a dialog box appears with the information. When finished reading the information, click the dialog box to make it disappear.
Exit

Exits the PhotoGrav program after checking if that is really what you want to do. However, no check is made if the “Minimize Cautionary Messages” checkbox is checked in the Preferences window.

4.2.3 Menus

The Menu Bar for the Modify Material window contains the following Menu Headings:

```
File    Tools    View    Help
```

Each of these menus is listed and described in the following. Some of the menu items are disabled until certain events occur.

File Menu

```
Exit
```

The “Exit” item causes the same action as clicking the Exit command button on the TaskBar as described near the end of Sec. 4.2.2.

Tools Menu

```
Reselect Engraving Material
Interactive Process
Automatic Process
```

The “Reselect Engraving Material”, “Interactive Process”, and “Automatic Process” items cause the same action as the Reselect Material, Interactive Process, and Auto Process command buttons on the TaskBar as described near the end of Sec. 4.2.2.
View Menu

The "Hide Tool Bar" item causes the Tool Bar (also called the TaskBar) to be hidden. When the TaskBar is hidden, this menu item becomes "Show Tool Bar".

Help Menu

The Help Menu for the Modify Material window is nearly identical to the Help Menu for all other windows and is described in Section 3.1.3

4.2.4 Status Bar

The Status Bar consists of four panels. The first panel from the left contains the name and complete path of the input image. The second panel from the left toggles between: (1) the engraving material (followed by a hyphen and a Named Parameter Set name if any is active) and (2) the laser engraver name and the settings for the engraver. Clicking the panel will cause it to alternately display one of these two items. The last two panels contain the current date and time, respectively.
4.3 DPI Specification Window

4.3.1 Functions

The **DPI Specification** window (see Fig. 4.3-1) can only be invoked from the **Input Selection** window and provides the capability to change the dpi (dots per inch) associated with the current Original (input) image. This window is automatically invoked if an Original (input) image has an invalid dpi or you can invoke it from the File Menu of the **Input Selection** window to temporarily change, during the period of **PhotoGrav**'s execution, the dpi associated with any Original Image.

![DPI Specification Window](image)

**Fig. 4.3-1: “DPI Specification” Window**

4.3.2 Controls

The current dpi for the input image is specified in the first paragraph near the top of Fig. 4.3-1, (a value of 300.0 for this example). A new value for the dpi can be entered in the white text box in the lower-left portion of the window (contains 250 for this example). Clicking the “OK” command button will cause that dpi to be assigned to the input image for the duration of this **PhotoGrav** execution. Clicking the “CLOSE” command button will retain the current dpi for the image.
4.4 Info Report Window

4.4.1 Functions

The **Info Report** window (see Figs. 4.4-1a and 4.4-1b) can be invoked from either the **Input Selection** or the **Engraving Results** window. If invoked from the **Input Selection** window, then the **Info Report** window displays all available information about the Original (input) image, the engraving material, the current processing parameters, and the Laser Engraver parameters currently being modeled by **PhotoGrav**. If invoked from the **Engraving Results** window, it also displays processing results such as the **PhotoGrav** processing time, the estimated engraving time for your laser engraver, etc.

Fig. 4.4-1a below depicts the entire **Info Report** window but the medium-gray section of the report (contains the titles **Input Image** and **Process Parameters**) is only partially visible (note the scroll box in the right-hand scroll bar). Fig. 4.4-1b presents the remainder of the medium-gray section, with some overlap, from the same report.

Fig. 4.4-1a: “Info Report” Window (showing top part of medium-gray section)
Fig. 4.4-1b: “Info Report” Window (bottom part of medium-gray section only)

4.4.2 Controls

The top section of the report (darker gray in Fig. 4.4-1a) presents information about the PhotoGrav version in use, the session duration, and the current date and time. The remainder of the report contains one to three sections depending on which window invoked Info Report and whether or not an input image was opened at that time. The three sections of the report contain information about the Input Image, the Process Parameters (including the engraving material, any Named Parameter Set that was in effect, and the Laser Engraver parameters) and the Process Results. The medium-gray section scrolls if all the information cannot fit the display screen. The light-gray text box near the bottom of Fig. 4.4-1a, titled “Engraver’s Comments” provides a space for you to enter comments and notes to supplement the other information. If you choose to print the report, these comments are included in the printout at the bottom of the page.

The “Print Report” command button near the bottom of the window prints the report information on any Windows compatible printer that you have connected to your computer. The standard Window's Print dialog box is first invoked so you can choose which printer you want to use (if you have more than one connected) and so you can set the print options for that printer. The “Close” command button closes the Info Report Window removing it from the screen. All the information is still available to PhotoGrav so the Info Report can be invoked again if desired.

The “?” command button provides context-sensitive Help for any enabled control. Left clicking the “?” causes the cursor to change into a “?”. Position the “?” cursor on a control about which you want information, click, and a dialog box appears with the information. When finished reading the information, click the dialog box to make it disappear.
4.5 Print Window

4.5.1 Functions

The Print window (see Fig. 4.5-1) can be invoked from either the Engraving Results or the Text/Resize window. This support window provides the capability to print images at actual size or at a size scaled to the size of your paper. Generally, the identity of the image to be printed has already been specified by some mechanism in the primary window that invokes the Print window so that specification is not part of the following description.

![Print Window](image)

*Fig. 4.5-1: “Print” Window*

4.5.2 Controls

The first of two options, “Fit to Page” specifies that the image will be scaled and printed at the largest size that will fit on the paper you are using. The image is printed with a descriptive caption so PhotoGrav scales the image in a manner that leaves room for the caption. The caption includes the type of the image (Original, Engraved, or Simulation), the name of the image if it has been saved to disk, the name of the Original Image from which a processed image was derived, and the current date and time.

The second option, “Actual Size” specifies that the image will be printed at its actual size, i.e., as specified by the number of pixels, the number of lines, and the dpi of the image. If the image is larger than the margins of your paper, it will be scaled in the same manner as it would have been for the “Fit to Page” option. The image is printed with a caption which contains the same information as the caption described in the preceding paragraph.

The “OK” command button closes the Print window and invokes the standard Window's Printer Dialog Box so you can specify which printer you want to use and the options for the selected printer. The image is then printed unless you cancel the operation in the Printer Dialog Box. The “Cancel” command button closes the Print window, cancels the print operation, and returns you to the window from which the Print Window was invoked.
5.0 Introduction

There are five ways of getting help with any problems that you might encounter in using and understanding PhotoGrav. The first way is to check this document, the PhotoGrav User Guide. Chapters 1 and 2 of the document provide an overview of how PhotoGrav works and present summaries of important operational considerations. Chapters 3 and 4 then provide in-depth information about each of PhotoGrav's components and essentially serve as reference chapters.

The second way to obtain help, available during a PhotoGrav session, is by using the context-sensitive help that is provided for almost every PhotoGrav window and control. Context-sensitive help is described in Sec. 5.1 below.

The third way to obtain help, also available during a PhotoGrav session, is by using narrative help. Narrative help provides information in a format similar to that provided by the User Guide but is much less detailed. Narrative help is described in Sec. 5.2 below.

The fourth way to get help is to check Sec. 6.1, "Solutions to PhotoGrav Problems", which lists some of the more common difficulties that you might encounter when using PhotoGrav. The solution to your specific problem might already be answered in this section.

The fifth way to get help, when all else fails, is to request technical support. The procedures for doing this are specified in Sec. 6.2, "Technical Support".

5.1 Context Sensitive Help

Context-sensitive help is provided for almost every PhotoGrav window and control (command button, text box, list box, etc.) and is available on-line during a PhotoGrav session. Context-sensitive help is accessed via the blue "?" command button located near the upper-right corner of each PhotoGrav window. Left-clicking the "?" causes the cursor to change into a "?". Positioning the "?" cursor to a control about which you want information and then clicking on that control, causes a dialog
box to appear with the information. When finished reading the information, clicking on the dialog box makes it disappear. If you click with the "?” cursor anywhere on a window but not on a control, then PhotoGrav displays a dialog box that presents information about the window itself.

If a control is not enabled (grayed), then context-sensitive help is not available for that control until it is enabled (Generally, a control is not enabled if the action it normally produces is not appropriate for the current situation, e.g., a command button for printing an image might not be appropriate if no image is yet displayed.).

You can make a context-sensitive dialog box disappear by clicking anywhere on the window. However, it is safest to click on the dialog box itself because otherwise the "click" will sometimes "leak through" to a control and cause a possibly-unwanted action.

---

5.2 Narrative Help

Narrative help is available during a PhotoGrav session from the Help menu that occurs on each PhotoGrav primary window. Narrative help is similar in format to the PhotoGrav User Guide but contains much less detail. It is intended to provide an overview of PhotoGrav's operational flow to assist the on-line user in understanding PhotoGrav's major concepts. The narrative help is complemented and supplemented by the very detailed help available from the context-sensitive help feature described in Sec. 5.1.

The Help menu contains the five items listed below and described in detail in the following sections:

Table of Contents
"Current Window" Window
Search for Help On...
How to Use Help
About PhotoGrav

In the above, the term "Current Window" represents the name of the PhotoGrav window (e.g., Input Selection, Interactive Process, etc.) that is active at the current point in time.

5.2.1 Table of Contents

This menu item displays the table of contents for the on-line narrative help. The organization of the narrative help is similar to the organization of the PhotoGrav User Guide and contains the following major topics:
I. Introduction
II. Operational Overview
III. Quick Start
IV. Primary Windows
V. Support Windows
VI. Troubleshooting
VII. Appendices
VIII. Glossary

The Table of Contents is also available from the main "Help" window at any time by clicking the "Contents" command button on the toolbar near the top of that window or by repeatedly clicking the "<<" command button which is on the same toolbar.

5.2.2 "Current Window" Window

As noted before, the term "Current Window" represents the name of the PhotoGrav window (e.g., Input Selection, Interactive Process, etc.) that is active at the current point in time. This menu item immediately displays that portion of the narrative help that is applicable to the window that is currently active.

5.2.3 Search for Help On...

This menu item provides the capability for you to type a keyword into a dialog box to search for topics associated with that keyword. After doing so, a list of topics is presented from which you can choose to access information that relates to the keyword. The search capability is also available from the main "Help" window at any time by clicking the "Search" command button on the toolbar near the top of that window.

5.2.4 How to Use Help

This menu item displays the standard Windows "Using Help" topics.

5.2.5 About PhotoGrav

This menu item displays a small window that provides information about PhotoGrav including the version number and date of the PhotoGrav version that you are using. The window also contains licensing information including the serial number of your license. This is the serial number that you must supply if you call us for technical support. Also displayed are the copyright notice and the usual warnings about copyright infringement. In addition, a short animation is presented which "engraves" a
welcome message on a piece of cherry wood.
Chapter 6

Troubleshooting

6.0 Introduction

This chapter consists of two parts. Section 6.1 presents solutions to problems you might occasionally encounter when using PhotoGrav. Section 6.2 specifies how to get technical support for any further difficulties you might have with PhotoGrav.

6.1 Solutions to PhotoGrav Problems

6.1.1.1 Problem

I click the PhotoGrav icon (the twirled star) to start PhotoGrav and absolutely nothing happens.

6.1.1.2 Solution

There is probably another copy of PhotoGrav currently running in a minimized window. Check the Windows TaskBar (Windows 95) or the desktop (Windows 3.x) for any minimized PhotoGrav icons and close any running versions that you find. Then try again to start PhotoGrav. If this does not solve the problem, seek technical support as specified in Sec. 6.2.
6.1.2.1 Problem

I tried to "Print" directly to my engraver from the PhotoGrav program and it did not work. Why not?

6.1.2.2 Solution

PhotoGrav does not currently interface directly to the specific "Printer" drivers supplied with most laser engravers. To engrave, save PhotoGrav's "Engraved Image" to disk and use the program that you normally use for engraving (for example, CorelDraw), to send that image to the engraver. The "Engraved Image" produced by PhotoGrav is a binary image and should NOT be resized nor rotated once produced.

6.1.3.1 Problem

Occasionally one of my engraved images from PhotoGrav has a funny checked pattern.

6.1.3.2 Solution

This problem is probably caused by one of two conditions: (1) Your image dpi does not match your engraver dpi, or (2) Your image has areas of solid gray tones, a common occurrence for exported clip art, and PhotoGrav's processing causes repetitive patterns in these solid areas.

To correct the problem: (1) Change the dpi of the input image and/or make sure the machine dpi is set correctly OR, (2) Use the PhotoGrav "Noise Gain" function (see Sec. 3.2.2.2.3) to break up any patterns.

6.1.4.1 Problem

The free space on my disk seems to be getting smaller even though I have not saved any new images on that disk.

6.1.4.2 Solution

If PhotoGrav terminates abnormally (e.g., a power outage or program failure), then it is possible
that some of PhotoGrav's temporary files were not deleted from the disk. These files would occur in the \Temp subdirectory of the PhotoGrav root installation directory and would have an extension of ".tmp". You can delete any such files using File Manager or Windows Explorer BUT make sure that PhotoGrav is not currently running (It would be especially easy to overlook the fact that PhotoGrav was running if it were running in a minimized state. If running, then it would be normal for .tmp files to be in the \Temp subdirectory and they should NOT be released in this case).

This problem should only occur rarely, if ever, and in fact it might occur, and be fixed, without your knowledge since PhotoGrav would probably clean up the .tmp files during its next execution with no action required on your part.

6.1.5.1 Problem

The PhotoGrav installation program will not run to completion. It complains about some file not available because it is currently being used by some other program.

6.1.5.2 Solution

Make sure that you have closed all running programs before attempting to install PhotoGrav. If you are on a network, log off the network before beginning the installation. Novell networks in particular seem to cause installation problems for some programs.

6.2 Technical Support

Before requesting technical support, please:

- See the "Read Me" file installed with PhotoGrav for last-minute information not included in the user guide. The "Read Me" file also contains a summary of some of the most important information that you should know about PhotoGrav and that information might be adequate for addressing your problem.
- Check the preceding section, Sec. 6.1, for the possibility that your problem is already addressed in that section.
- Check the appropriate section of the user guide for detailed information about the PhotoGrav component that is causing you difficulty. Chapters 3 and 4 are essentially
reference chapters and contain very detailed information that you might have overlooked in your first perusal of the document.

When you have determined that you definitely need technical support, the most efficient manner in which to receive that support is via email. The next most efficient means of requesting support is by FAX. However, if you need an immediate response, or if the email or FAX response is for any reason inadequate, then call one of the appropriate numbers listed below. Technical support is available Monday through Friday, 9:00 a.m. to 5:00 p.m. (Eastern Standard Time).

When requesting technical support, whether by email, FAX, or phone, please have available the following information:

- Your full name and the name of the registered user, if different.
- Your street address, phone and fax number, and email address.
- The version number and the serial number of your copy of PhotoGrav.

Both of these numbers should be available in the "About PhotoGrav" dialog box accessible on the Help menus while executing the program. The serial number should also be available at the bottom of page i of the PhotoGrav User Guide.

- As much of the following system information for the computer you are using as possible:
  - Make and model of the machine
  - Operating system
  - Quantity of memory
  - Video driver (if known)

- A detailed description of the problem. Please try to list the steps and conditions which led to the problem and any error messages that were encountered.

For support with the PhotoGrav program itself, e.g., something doesn't seem to work right when PhotoGrav is executed or some sort of error is reported during execution, contact:

Schrock's Computer Works
60232-1 State Road 15
Goshen, IN 46528

Email: bryce@npcc.net
FAX: (574) 534-5047
Phone: (574) 534-0906
Comments about PhotoGrav's current performance and suggestions for improvements and additions to future versions would be appreciated and can be emailed or mailed to the address provided above.
Appendix 1

PhotoGrav Tips

A1.0 Introduction

This Appendix consists of "tips" which might make your PhotoGrav sessions more efficient or which might suggest possibilities that had not occurred to you. Most of the information in the tips is referenced elsewhere in the document, at least implicitly, but perhaps was overshadowed by other detailed information. The tips are compiled below as a list in no particular order other than some attempt to arrange them in descending order of usefulness.

A1.1 PhotoGrav Tips

1. If you are executing PhotoGrav and are in the Interactive Process window, you can change the engraving material that you are using, without going to the Input Selection window, by clicking the Load Params command button.

That action initiates an "Open Engraving Parameters File" dialog box wherein you can enter the name of any Named Parameter Set which you have previously created OR one of the standard PhotoGrav parameter sets which correspond one-to-one to the standard engraving materials (see Sec. 2.3 for a list) and which are located in the /Params subdirectory of the PhotoGrav installation directory. After the parameter set is specified, the appropriate engraving material becomes immediately effective, with all stored parameters in effect, and the thumbnail images in the Interactive Process window change appropriately.
2. You can temporarily change the dpi (dots per inch) for an Original (input) Image by choosing the "Change Image dpi" item on the File menu in the Input Selection window.

You might want to do this, for example, if your engraver dpi is not an integral factor of the input image dpi (see Sec. 2.3 for comments on Engraver & image dpi). Changing the dpi of the input image ALSO CHANGES THE SIZE (IN INCHES) of the image. The new size is noted near the bottom of the DPI Specification window (see Sec. 4.3) which appears when the "Change Image dpi" item is selected.

3. You can significantly reduce PhotoGrav’s execution time and its scratch disk requirements by setting your preferences so that PhotoGrav produces no simulations and/or no engraving time estimates.

To accomplish this, select the "Preferences" item from the File menu in the Input Selection window. In the Preferences window which then appears, uncheck both or either of the "Simulated Engravings" and "Estimates of Engraving Times" check boxes. PhotoGrav execution times, with and without these features, are listed below for two sample input images for engraving on black laser brass:

2.82" x 2.86" image @ 250 dpi (705 x 715 pixels)

- 25 sec. simulations with time estimates
- 23 sec. simulations with no time estimates
- 11 sec. no simulations with time estimates
- 9 sec. no simulations and no time estimates

6" x 6.65" image @ 250 dpi (1500 x 1662 pixels)

- 89 sec. simulations with time estimates
- 81 sec. simulations with no time estimates
- 37 sec. no simulations with time estimates
- 29 sec. no simulations and no time estimates

The above timings were done on a 100Mhz Pentium machine with 48 MB of RAM. As indicated by these sample cases, the time savings can indeed be significant. However, the time savings must be weighed against not having a simulated image to judge what the final engraving will look like. Also, the Text/Resize window is not available if the simulation capability is turned off.
4. You can view the actual Engraved (binary) image that will be sent to your engraver by proceeding to the Text/Resize window and clicking the "Finished" command button.

Doing so brings up a display of the Engraved Image in the right polarity (and possibly mirrored) for your engraver. You might want to do this in your initial PhotoGrav sessions to reassure yourself that PhotoGrav is "doing the right thing". The simulations that PhotoGrav produces are always in a "What You See Is What You Get" (WYSIWYG) format so you can judge if the eventual actual engraving is going to be satisfactory. Further, displays of the "Engraved Image" in the Interactive Process and Engraving Results windows are kept in the polarity, and left-to-right orientation, of the Original (input) image so you can readily compare to that image to see what the processing has done to the image. That is all very nice BUT at some point you might wonder if PhotoGrav will prepare the binary image properly for transmission to the engraver. For example, if you are preparing a photo for engraving on acrylic, you might be concerned whether or not PhotoGrav will both reverse the polarity AND mirror the image. Looking at a final display of the Engraved Image should reassure you on both points.

There is one case where, at your option, the display of the Engraved Image might not be identical to the binary image that would be transmitted to the engraver. That case occurs for engraving materials, e.g., acrylic, that normally require a left-to-right mirror operation since they are usually engraved on the "back" of the material. In this case, you are presented with an option for how the image is to be displayed and how it is to be saved to disk, flipped left-to-right or not. If you have elected to "Minimize Cautionary Messages" (see Sec. 4.1.2.2), then you are not presented with the option and the image is automatically displayed NOT FLIPPED but is saved to disk FLIPPED.

5. You can use the Modify Material window to create plastic engraving materials that have just about any solid color "cap" with either black or white "cores".

To accomplish this, in the Input Selection Window click the "Modify Material" command button (after selecting the input image). In the list of engraving materials, under Plastic, select the material "User-Defined Cap/Black Core - Plastic" and click "OK". On the resulting screen, use the horizontal scroll bars to change the "Green Tint" and "Blue Tint" to values of -1.00. The smaller swatch of engraving material, above the scroll bars, should then be red. You can then "Interactive Process" or "Auto Process" using this material. While this material is active, you can also use the "Save Params" button in any window to save this material to disk as a Named Parameter Set. It is then available at any time in the future with the color which you just specified.
6. A convenient manner in which to view the "Image Out" (right-hand) thumbnail in the Interactive Process window is to click points on the "Image In" (left-hand) thumbnail which are then viewed at full resolution on the right-hand thumbnail.

To accomplish this, ensure that the "Synchronized" check box (between the two thumbnails) is NOT checked. Then click on the right thumbnail until its scale factor is 1.00 (indicated by the right-hand number in the blue "Scales =" box at the top-center of the window). The area which fills the entire right thumbnail should then be indicated by a yellow square on the left thumbnail. Clicking anywhere on the left thumbnail will center the yellow square on the clicked point and the area surrounding the point will be displayed on the right thumbnail with no change in scale factor, i.e., it should still be equal to 1.00. Obviously, the same technique can be used for scale factors other than 1.00. Just left-click or right-click on the right thumbnail until the desired scale factor is achieved. Then click on the left thumbnail as before.

7. You can use PhotoGrav to produce binary images for some applications that require "screened" images.

Sometimes when images are processed with a normal halftone screen, e.g., for magazine or newspaper ads, the results are less than good. In some cases, PhotoGrav can produce a superior binary image that might satisfy such requirements. To accomplish this, open the input image and click the "Interactive Process" command button on the Input Selection window. Within the Interactive Process window, right-click the Simulation function box to turn it OFF (It should change color from green to white). Then use the functions that are still ON to adjust the appearance of the right thumbnail (You might want to have the "High Quality" check box checked when doing this). When satisfied with the result, click the "Proceed" command button which displays the result in the Engraving Results window. Within this window, use the "Cycle Images" command button to compare the binary (Engraved) image to the Original (input) Image. Then, click the "Save Engraved" command button on the ToolBar or select the "Save Engraved Image" item from the File menu to save the binary image to disk.
Appendix 2

Engraving Tips

A2.0 Introduction

This Appendix consists of Engraving "tips" which should assist you when you are ready to actually engrave the photographs that you have processed in PhotoGrav. The tips are provided for a variety of the most common engraving materials that are suitable for engraving photographs. The tips are primarily "finishing tips" that should enhance the appearance of the engraved photos.

A2.1 Engraving Tips

1. Increasing the contrast on Cherry (or Maple) wood plaques.

After engraving, the use of liquid shoe polish will darken the engraved areas thus increasing the contrast. Care must be taken to prevent dye from bleeding under the plaque surface into the pores of the wood, permanently damaging the plaque. You will need the following supplies:

- Brown & Neutral Kiwi brand liquid shoe polish with foam applicator top
- Paper towels
- Leather chamois
- Water

Follow these steps for best results (first you seal it, then you dye it):

a. The cherry plaque should have a lacquered finish; it should NOT be raw wood.
b. Laser engrave the plaque dry and unmasked.
c. Wet the chamois and fold it to result in a pad that is several layers thick and about 4"x4" in size. Wring out the chamois so it is well soaked but not dripping.
d. Smooth out the chamois so it is a nice flat pad.
e. Seal the engraving by using the NEUTRAL polish. Using the foam applicator, liberally dab the polish on the engraving and brush around to cover all engraved areas.

f. Immediately wipe off the excess polish with a clean pad of paper towel, quickly followed by the wet chamois. Wipe lightly and briskly to clean the surface without pulling lots of dye from the engraved recesses. You may need to re-fold your chamois pad several times to maintain a clean wiping surface.

g. Let the neutral dye dry for 10 min. to seal the wood pores.
h. Repeat the same procedure with the BROWN dye to darken the photo.

Shoe dye dries quickly and it is difficult or impossible to remove stains if you go too slowly and let it dry unevenly. Rubbing alcohol will clean some stains, but use sparingly as it can attack some wood finishes.

2. Engraving photos on Walnut wood plaques.

Walnut is a traditional wood in the industry but it surely does not work well for photo laser engraving since it tends to be quite dark and therefore results in very little contrast. If your customer insists on using walnut for a photo engraving, first try to convince him/her to let you put the photo on a separate plate like black brass or, better yet, the new Spectrum Lights ultra thin engraving material - it works fantastically well for photo engraving. If you do need to laser the photo into walnut, then use PhotoGrav settings for walnut that result in higher contrast and very little, or no, dot-dither shading so the processed image looks similar to a line drawing. Then, after engraving, use the dye procedure described in tip #1 above to attempt to get more contrast. However, use BLACK dye instead of the brown. Also, it is not necessary to seal the engraving first (with the neutral polish) because the walnut wood grain is tighter than cherry or maple so the polish won't bleed into the grain.

3. Engraving photos on Oak wood plaques.

Don't even waste your time trying it. Oak is very porous and has an uneven grain hardness. These characteristics result in a very inconsistent and uneven engraving. Also, if you try to increase contrast using the dye technique of tip #1, then the dye bleeds like crazy under the plaque surface. Oak is light colored but the laser engraving is light also so your photo will not show up well at all.
4. **Engraving photos on Acrylic.**

Engraving on the back of the plaque, with the photo flipped left-to-right, always looks better than engraving on the face of the plaque. (*PhotoGrav* automatically processes photos for "back" engraving on acrylics unless you override the default).

Cast type acrylics produce a nice white frosty cut, but extruded acrylics (usually 1/4" and thinner) result in engravings that are mostly clear which is usually not very good for photos.

To engrave an acrylic plaque, use very low power settings - just enough to frost the surface on clear acrylic or remove the paint on painted acrylic (*PhotoGrav* automatically sets an appropriate power value when acrylic is the selected material). Engrave the plaque after removing the paper mask and let it dry. After it is dry, gently wipe any white dusty residue off with a clean, dry cloth. Then polish with a different clean, dry cloth using Novus #1 plastic polish. Spray the polish sparingly on the product and clean with the cloth. Use a dry spot on the cloth to buff dry.

5. **More ideas for engraving photos on Acrylic.**

Vector cut shapes or silhouettes from clear 1/8" acrylic and then engrave portraits, or other photographs, on the cutouts.

Laser engrave the photo, wipe it clean, and color it with permanent markers or spray paint. Let the paint dry and then sand off the back, leaving a frosted looking background with a color filled photo. (*Note:* With this technique, you would *PhotoGrav*-process the image in positive polarity, not negative. *PhotoGrav*'s default polarity for acrylic is negative so you must override this default)

Spray paint the back of an extruded acrylic plaque before engraving. (We recommend Krylon brand spray paint.) Laser engrave the photo through the paint. Since it is extruded acrylic the engraving should be fairly transparent, so paint it again with another color, or back up with a shiny piece of gold, silver, or colored metal to show through the photo.)

If, after engraving, the engraved areas are not very white looking, you might be using too much power, not too little. Try a lower laser power setting. Aluminum tends to have a narrow power response band for which the material turns nice and white. Too much power turns the aluminum a light yellowish color. Too little power does not remove all of the black anodized coating.

No clean up is normally needed but window cleaner works well if any is needed.

7. Engraving photos on Corian brand solid surfacing materials.

This material engraves nicely and is easy to color fill.

a. Engrave your photo.
b. Scrub out the engraving with hot soapy water and a toothbrush. Rinse thoroughly and blow out with compressed air.
c. Let dry.
d. Dab enamel paint into the engraved areas.
e. Using a piece of card stock, squeegee the excess paint off. This action also forces paint into the little dots in the photo.
f. Let the paint dry.
g. Wet sand with a block using 220 grit wet-dry sandpaper to remove the rest of the paint from the face of the plaque.
h. Buff with a very fine scotch brite pad.
i. Rinse the plaque off and let it dry.
j. Polish the plaque with automotive wax or a good counter top polish like Hope’s brand polish.

This type of plaque holds up well outdoors. It provides a great alternative to cast bronze and works well with photos also!

Alternative, indoor use only:

a. Use solid white Corian and engrave a photo or clip art
b. Use Permanent Markers to color the engraving in a rainbow of colors.
c. After the plaque is dry, it can be sanded. An easier method, however, is to wipe the surface with a block wrapped in a paper towel that has been dampened with rubbing alcohol.
8. Engraving photos on Spectrum Lights marking material.

This is a newer material, with a satin brass appearance, that works exceptionally well with PhotoGrav processed images. It is very thin, about .004", and comes with adhesive already on the back. Engrave the material dry and unmasked at very low power. (PhotoGrav defaults to a very low power setting for this material). No clean up is needed after engraving.

Then, using your laser vector cutting capability, cut out the picture as an oval frame or some other interesting shape. Then you just peel off the backing and stick it on your plaque or anywhere. Great stuff!

9. Engraving photos on coated Laser Brass, black or colors.

Only use brass that is specifically made for laser engraving. This brass is shiny under the coating unlike the traditional black brass that is dull gold under the surface. Engrave the material dry and unmasked at just enough power to cleanly remove the coating and expose the brass. A larger power setting will wash out the detail in your image because brass does not absorb CO₂ laser energy and therefore the excess energy is simply "spread" out, blowing away the details. It is best to not polish the engraved plate very much. However, you might want to shine the plate up using a little Pledge furniture polish on a soft, clean cloth. Most paper towels can scratch brass plates, so it is best not to use them. If you do use paper towels, the only ones to use are Bounty brand towels since they tend to scratch less.

10. Reducing the white/frosty appearance of some wood engravings.

This "frosted" effect is caused by the laser not fully penetrating the clear finish on a plaque, especially in areas where there are few dithering dots. This effect can be reduced with a product know as "Almond Stick" which can be ordered from the Fuller Brush Company or can be found in some woodworking supply catalogs, furniture stores, or hardware stores. After engraving, you simply dab some of this product on the plaque surface and buff off with the palm of your hand. Most of the "white stuff" is subsequently hidden. Almond stick also hides small nicks and dings on wood plaques.
11. Engraving photos on Vinyl wrapped particle board plaques.

Most light colored plaques of this type are okay for engraving photos. After engraving, the "Black dye" procedure described in tip #1 works quite well.

The melamine type laminated plaques like PDU brand Spectra-Lights work exceptionally well for photo engraving. They accept dye and color fill readily and their surface is much more durable than most. Quail brand melamine plaques also work quite well.

One note of caution: Some of the cheaper plaques of this type may swell up around the engraved areas after you get them wet using the "Black dye" method. It is always wise to test your own suppliers' plaques before you commit to any job.

We hope these finishing tips are helpful and profitable to your business. It has taken years of trial and error, wasted materials, seminars, and talking to others at trade shows to develop these techniques for engraving photos that work well in our shop. The tips described above are techniques we really use in our daily production, and they do work. We continue to refine and test new ideas, but hopefully this existing information will already save you lots of time and money. Have fun.
Appendix 3

Calculational Procedure for “Turn Time”

A3.0 Introduction

This Appendix presents a procedure for calculating the “Turn Time” parameter which is used in the algorithm which estimates the time in seconds for an image to be engraved on your machine. See Sec. 4.1.2.2 for a brief description of the parameter and how it should be specified in the Preferences window of the PhotoGrav program.

Section A3.1 describes a simple procedure which you can use to calculate the “Turn Time”. Section A3.2 describes a somewhat more complex procedure which you can use to calculate the “Turn Time” under more varied conditions so that you can perform some consistency checks on the calculational procedure. Section A3.3 then presents the model used to derive the calculational procedure and the rationale behind that model.

A3.1 Simple Procedure

This section describes a relatively simple procedure for calculating the “Turn Time” parameter.

Procedure

1. Prepare two grayscale images in a format that is acceptable for sending to your laser engraver. Make the first image a black square that is 1" wide (along scan) by 1" high (across scan). Make the other image a black rectangle that is 2" wide (along scan) by 1" high (across scan). Produce the images at the same resolution that you intend to use on the laser engraver, e.g., 250 dpi would probably be a good choice for a ULS machine and 300 dpi would probably be a good choice for an Epilog or LMI machine.
A. To accomplish this in CorelDraw, start CorelDraw and create a new blank page as you would for any engraving job. Select the rectangle tool and draw a rectangle exactly 1.00” tall x 1.00” wide, approximately centered on the page (turning the snap to grid on will make this easier). Select the pick tool and select the rectangle you just drew. Fill the rectangle with solid black by using the paint bucket tool. Set the outline to none by using the outline tool. Save this file as 1X1.CDR. Repeat the procedure and create a 1.00” tall x 2.00” wide image and save it as 1X2.CDR.

B. To accomplish this in Adobe PhotoShop, start PhotoShop and set the Background color to black. Then, from the File menu, select New. In the dialog box that appears, set the Width to 1”, the Height to 1”, the Resolution to 250 or 300 pixels per inch, the Mode to Grayscale, and for the Contents select the option for "Background Color". Then click the "OK" command button. Save the image in any format that you can send to your engraver and give it a name so you can remember it as the 1” square. Repeat this process to create the 2” x 1” black image.

The images you have produced should appear as depicted in Fig. A3.1-1.

![Fig. A3.1-1: Test Images](image)

2. Engrave each of the two images making sure that your engraver is in raster mode, not vector mode, and that the speed is set to its maximum value (100%). Also, set the engraver resolution, \( r \), to the same value as that used to create both images, e.g., \( r = 250 \text{ dpi} \) or \( r = 300 \text{ dpi} \). Record the time in seconds that it takes, as measured by your engraver, to complete the engraving. Designate the time to engrave the 1” x 1” square as \( T_1 \) and the time to engrave the 2” x 1” rectangle as \( T_2 \).

3. Calculate the "Turn Time" parameter, \( t \), using the following formula:

\[
t = \frac{(2T_1 - T_2)}{r}
\]

where
- \( t \) = "Turn Time" parameter in seconds
- \( T_1 \) = Time (in seconds) to engrave the 1” x 1” square
- \( T_2 \) = Time (in seconds) to engrave the 2” x 1” rectangle
- \( r \) = Engraver & image resolution in dots per inch

A3-2
For example, if $T_1 = 46$ seconds, $T_2 = 56$ seconds, and $r = 250$ dots per inch, then $t = 0.144$ seconds and that is the number (0.144) which should be entered for the "Turn Time" parameter in the Preferences window as specified in Sec. 4.1.2.2.

4. Perform the following check to see if the measured numbers make sense. Calculate, from the measured numbers, the maximum speed, $s$, for your engraver using the following formula:

$$s = r / (T_2 - T_1)$$

where $s$ is measured in inches per second.

Using the same example numbers as those used in step 3, we get $s = 25$ inches per second for the maximum speed of the laser engraver used to generate the samples.

If, using the numbers you have measured, the value of $s$ is not close to the maximum speed of your engraver as specified in your engraver documentation, then the value for the "Turn Time" parameter, $t$, as calculated in Step 3 is probably not reliable and any engraving time estimates which PhotoGrav produces are also not reliable. If engraving time estimates are important to you, then request assistance as specified in Chapter 6.

---

**A3.2 More Complex Procedure**

The procedure described in this section is actually not any more complex than the procedure described in Sec. A3.1 but it does require a few more variables for its specification. However, as a result, it is considerably more general than the previous procedure and will allow you to calculate the "Turn Time" parameter with higher precision and to perform consistency checks by measuring the parameter under several conditions.

**Procedure**

1. Prepare two grayscale images in a format that is acceptable for sending to your laser engraver. Make the first image a black rectangle that is $w_1$ inches wide (along scan) by $h_1$ inches high (across scan). Make the other image a black rectangle that is $w_2$ inches wide (along scan) by $h_2$ inches high (across scan). Produce the images at the same resolution that you intend to use on the laser engraver, e.g., 250 dpi would probably be a good choice for a ULS machine and 300 dpi would probably be a good choice for an Epilog or LMI machine. The images can be produced in CorelDraw or PhotoShop by small modifications to the procedures described in Sec. A3.1, Steps 1A and 1B. The images you have produced should appear as depicted in Fig. A3.2-1.
Fig. A3.2-1: Test Images

2. Engrave each of the two images making sure that your engraver is in raster mode, not vector mode, and that the speed is set to its maximum value (100%). Also, set the engraver resolution, r, to the same value as that used to create both images, e.g., r = 250 dpi or r = 300 dpi. Record the time in seconds that it takes, as measured by your engraver, to complete the engraving. Designate the time to engrave the first rectangle as $T_1$ and the time to engrave the second rectangle as $T_2$.

3. Calculate the "Turn Time" parameter, $t$, using the following formula:

$$ t = \frac{(h_1 \times w_1 \times T_2 - w_2 \times h_2 \times T_1)}{(w_1 - w_2) \times r \times h_1 \times h_2} $$

where

- $t$ = "Turn Time" parameter in seconds
- $T_1$ = Time (in seconds) to engrave the first rectangle
- $T_2$ = Time (in seconds) to engrave the second rectangle
- $r$ = Engraver & image resolution in dots per inch

For example, if $w_1 = 1''$, $h_1 = 2''$, $w_2 = 4''$, $h_2 = 1''$, $T_1 = 90$ seconds, $T_2 = 75$ seconds, and $r = 250$ dots per inch, then $t = 0.140$ seconds and that is the number (0.140) which should be entered for the "Turn Time" parameter in the Preferences window as specified in Sec. 4.1.2.2.

4. Perform the following check to see if the measured numbers make sense. Calculate, from the measured numbers, the maximum speed, $s$, for your engraver using the following formula:

$$ s = \frac{(r \times (w_2 - w_1) \times h_1 \times h_2)}{(h_1 \times T_2 - h_2 \times T_1)} $$

where $s$ is measured in inches per second.

Using the same example numbers as those used in step 3, we again get $s = 25$ inches per second for the maximum speed of the laser engraver used to generate the samples.

If, using the numbers you have measured, the value of $s$ is not close to the maximum speed of your engraver as specified in your engraver documentation, then the value for the "Turn Time" parameter,
t, as calculated in Step 3 is probably not reliable and any engraving time estimates which PhotoGrav produces are also not reliable.

The procedure described in this section provides much more flexibility than the simple procedure described in Sec A3.1. For example, one can use larger rectangles and/or a larger value for the engraver and image resolutions to increase the precision of the calculated "Turn Time" parameter. Or one can use several pairs of different-sized rectangles, calculating the parameter independently from each pair, to determine the consistency of the calculated values. If you get inconsistent numbers for the parameter, or if the maximum speed, $s$, calculated above is not close to the manufacturer's published value, then request assistance as specified in Chapter 6.

A3.3 Calculational Model

Consider the rectangular black object in Fig. A3.3-1 which is an image which is to be engraved.

![Diagram](image)

**Fig. A3.3-1: Image to be Engraved**

The width of the rectangle is "w" inches and the height of the rectangle is "h" inches. The "along scan" direction is horizontal in Fig. A3.3-1 and the cross scan direction is vertical. Assume that the image was created with a resolution of "$r$" dots per inch (dpi) and that it will be engraved at that same resolution. The region designated "Line 1 Turnaround region" in Fig A3.3-1 is the distance that the engraver requires, after scanning Line 1, to decelerate, move down \((1/r)\) inches, and to then accelerate to begin the scan for Line 2. There is one such region associated with every scan line to be engraved.
Assume that the time, "t", that the engraver spends in this region is independent of the engraving speed, "s", and is the same for every scan line. Then the time spent on each scan line is \((w/s + t)\) seconds where \(s\) is specified in inches per second, \(w\) is specified in inches, and \(t\) is given in seconds. The number of scan lines in the rectangle of Fig. A3.3-1 is \((r \times h)\) where \(r\) is given in dots per inch and \(h\) is measured in inches. Thus, the total time, \(T\), to engrave the rectangle is:

\[
T = (r \times h) \times (w/s + t)
\]

Now assume that we have two rectangles to be engraved, one of dimensions \(w_1 \times h_1\) and the other of dimensions \(w_2 \times h_2\). The total times, \(T_1\) and \(T_2\), to engrave these rectangles are given by:

\[
T_1 = (r \times h_1) \times (w_1/s + t)\quad \text{and}\quad T_2 = (r \times h_2) \times (w_2/s + t)
\]

These two equations can be regarded as two equations in two unknowns, \(s\) and \(t\) (although \(s\) is "known" from the manufacturer's literature, it provides a convenient check to regard it as an unknown). The two equations can be solved for \(t\) and \(s\) with the following solutions:

\[
t = \left( h_1 \times w_1 \times T_2 - w_2 \times h_2 \times T_1 \right) / \left( (w_1 - w_2) \times r \times h_1 \times h_2 \right)
\]

\[
s = \left( r \times (w_2 - w_1) \times h_1 \times h_2 \right) / \left( h_1 \times T_2 - h_2 \times T_1 \right)
\]

which are exactly the formulas used in Sec. A3.3. Note that the speed, \(s\), in these equations need not be the maximum speed of the engraver. That assumption was made in the preceding sections to simplify the procedures and explanations.

Obviously, the "Simple Procedure" described in Section A3.1 could be simplified even more by assuming that one does indeed know the speed of the engraver and then substituting that value of \(s\) directly in one of the two equations and solving for \(t\) directly. In that case, one need only make and engrave one rectangular image to determine \(t\) but this ultra simple procedure provides no consistency check at all.

The algorithm within PhotoGrav that calculates estimated engraving times is reasonably sophisticated in that it knows and uses the actual length of each line to be engraved (first "burn" to last "burn") and will not "time" regions for which no engraving is to be done. However, there is a risk in that sophistication in that, if the "printer" drivers used by a manufacturer are less sophisticated in controlling the engraver, then PhotoGrav's time estimates could differ substantially from actual engraving times for that particular engraver.
Appendix 4
PhotoGrav and Clip Art

A4.0 Introduction

This appendix describes how PhotoGrav can process clip art to create engravable images that are really quite amazing. Although the procedure is described for color clip art from the extensive CorelDraw collection, the procedure should be applicable to other clip art collections after appropriate modifications.

A4.1 Procedure for CorelDraw Color Clip Art

Laser engraving the clip art from the CorelDraw collection 'as is' often produces less than desirable results. In fact, many times the engravings are totally unacceptable. On the other hand, following a rather simple procedure and then processing with PhotoGrav will yield reliable results that are often quite spectacular. Adhering to this procedure, you can now offer any of the thousands of Corel images to your customers with confidence that the final engraving will be not only acceptable but highly appreciated as well. In addition, you will not have to spend hours tweaking the art and possibly scrapping a lot of material in the process. If you have tried lasering some of the Corel art, you are probably aware of some of the problems: "hidden" lines appearing in surprising areas, poor contrast between different-colored areas, poorly defined edges, loss of detail, coarse dithering, funny checked patterns, unpredictable shading and depth, etc. The procedure described below, using PhotoGrav for the processing, solves all of these problems and more.

1. Start CorelDraw and create a new blank page.
2. Import the desired clip art from the Corel CD. (or any other clip art source)
3. Resize the art to the size you want it to be for the engraving.
4. Draw a rectangle slightly larger than the art and center it over the art.
5. Select only the rectangle and set its fill and outline to NONE.
However, if you intend to engrave the clip art on a negative polarity material like black brass or black painted acrylic, then it is best to fill the padding rectangle with black so that only the clip art is engraved, not a rectangle cutout frame. Also, in this case, the rectangle must be put BEHIND the clip art. To accomplish this:

A. Select the rectangle and fill it with solid black, no outline.
B. From the "Arrange" menu, choose "Order" and then "To Back"
   (or press Shift+PgDn).

6. From the Edit menu choose "Select All" - this should select your art AND the invisible (or black) rectangle. (the rectangle is important because it forces Corel to pad your clip art export with a white, or black, border). If there are any other objects, or possibly a page frame, make SURE only your art and rectangle are selected.

7. With both the art and the rectangle still selected, choose "Export" from the File menu.
8. Select the "File Type" as "Windows Bitmap (.BMP) Uncompressed".
9. Give the file a name of your choice.
10. IMPORTANT: Make sure you check the "Selected Only" checkbox.
11. Click on "Export" and you will be presented with a dialog of choices for your .bmp export. Select the following options:
    
    Color = 256 shades of gray
    Size = 1 to 1
    Resolution = Custom (250 dpi for ULS machines; 300 dpi for Epilog and LMI)
    Anti-aliasing = (If available in your version of Corel, choose one of the following):
    
    Super sampling
    Normal sampling
    No Anti-aliasing

    "Super sampling" is the best choice since it retains more fine lines and results in smoother details. "Normal sampling" results in good edge smoothing but tends to fatten up fine details which are subsequently sometimes lost. "No Anti-aliasing" is not used for most art since it often results in jaggy edges.

12. Click on "OK" and a grayscale version of your clip art will be created.
13. Start PhotoGrav and load the .bmp image you just created.
14. Process the image with PhotoGrav and save the "Engraved Image".
15. Import this processed .bmp image back into your Corel layout and engrave it.

(IT IS VERY IMPORTANT, that you do NOT resize or rotate the processed image after you import it back into Corel. Doing so would destroy the special dithering pattern created by PhotoGrav.)
Additional Tip:

Try importing a photo into CorelDraw and adding a fancy border or oval frame from the clip art collection. Select all of this, export it as a .bmp file, and process with PhotoGrav as described above. We have used this technique to create some really cool engravings - customers love them and will pay top dollar for them.

Use your imagination and PhotoGrav's processing power! We would love to hear about your creative tricks.
Appendix 5

PhotoGrav Concepts and Design

A5.0 Introduction

This appendix presents the rationale behind several of PhotoGrav's concepts and, at a high level, the design necessary to realize those concepts. The information duplicates some of the material presented in Sec. 2.2 but provides more detail about PhotoGrav's model and about the procedures used to tune the parameterized processing algorithms for the engraving materials.

A5.1 PhotoGrav Concepts

The objective of the PhotoGrav program is to efficiently process digitized photographs so they can be engraved on a variety of common engraving materials with a high degree of confidence that the engraved photographs will be acceptable products. PhotoGrav achieves this objective in the following way:

1. It provides parameterized algorithms that have been found effective in processing photos for engraving.
2. It provides, for many common engraving materials, the algorithm parameters that result in near-optimal engraving for each material.
3. It provides an automated, or interactive, application of the algorithms to the subject photo for the currently-specified engraving material.
4. It provides a simulation of the engraving process so the "engraved product" can be inspected before it is actually engraved.

This section addresses "Basic PhotoGrav Concepts" as two major subtopics: (1) "Parameterized Algorithms and Engraving Materials" and (2) "PhotoGrav Simulation".
A5.1.1 Parameterized Algorithms and Engraving Materials

PhotoGrav provides four major algorithms for processing digitized photos into engravable (binary) images: (1) Grayshade Adjustments, (2) Smoothing and Edge Enhancements, (3) "Screening" (Dithering) Operations, and (4) Image/Screen Combinations and Thresholding. Each of these algorithms has several functional components and each component is parameterized to provide a broad range of possible effects. It is not the intent of this section to describe each algorithm and its components (see Sec. 3.2 for detailed algorithm descriptions) but rather to describe how the algorithms are "tuned" for each engraving material.

Basically, PhotoGrav's algorithms are "tuned" for a specific material by an iterative process utilizing a combination of: (1) PhotoGrav's simulation capabilities (described in the next section) and (2) experimental engravings on the specified material. An initial estimate is made, for the subject material, of what the parameters should be for each of PhotoGrav's processing algorithms. The initial estimate is then specified to the PhotoGrav simulation capability and the result is inspected on the computer monitor. Adjustments are then made to the initial parameters until the simulation appears to be near optimal for several digitized photos. The "Engraved Image" produced by PhotoGrav is then actually engraved on the subject material and inspected. Based on the inspection, further adjustments are made to the parameters, the simulation is repeated, and further engravings are produced. This process is repeated until further iterations produce no perceptible improvements in the engravings. The overall "tuning" process, although simple, is rather tedious and would be extremely difficult without PhotoGrav's simulation capabilities.

The derived parameters for the subject material are then stored as a data set specific to that material. When the engraving material is subsequently selected during a normal PhotoGrav session, these parameters are accessed and loaded as the current processing parameters. The stored parameters include flags that indicate whether or not certain special operations should be performed for the material. For example, for black brass, a flag indicates that this is a negative-polarity material and that the "Engraved Image" should be inverted from normal engraving polarity. Or, for black painted acrylic, flags indicate that this is not only a negative polarity material but also that the image should be mirrored horizontally before engraving. Any of the parameters specifying the processing for a specific material can be readily adjusted in PhotoGrav's Interactive Process window. Adjustments can then be saved as a "Named Parameter Set".

A5.1.2 PhotoGrav Simulation

Although the tuning process described above results in "near optimal" parameter settings for each engraving material, engraving results are still often somewhat image dependent. In other words, the settings that produce an excellent engraving for one image on a specific material might result in an engraving that is less satisfactory for another image using the same engraving material. Further, it is very difficult to view the raw processed image on a computer monitor and to judge from that display whether or not the final engraving will be satisfactory. To overcome these difficulties, PhotoGrav provides, optionally, a simulation of what the processed image will look like once it is actually engraved on the selected material.
**PhotoGrav**'s simulation capability is intended to provide a WYSIWYG (What You See Is What You Get) capability. In other words, the appearance of the simulated image on your computer monitor should be very close to the appearance of the actual engraving produced from the processed image (subject to some of the qualifying factors mentioned in Sec. 2.2). The simulated image is not merely an overlay of "dots" on top of a representation of the engraving material. Rather, it is a full-fledged simulation wherein a lens-power model, calibrated for each material, is used to calculate an **effective** spot size which is then "burned" into a representation of the engraving material. The word "effective" is emphasized in the preceding statement because the spot size that **PhotoGrav** uses for the simulation is the size of the spot that the laser creates on the subject material, not just the geometric cross section of the laser beam at the focal plane. The "effective spot size" is modeled as a two-dimensional Gaussian curve whose height (degree of burn) and width (area of burn) are dependent on the laser's power and speed settings, the lens, and the engraver's dpi setting relative to the image dpi. The effective spot size is calibrated for each material by engraving test images at several power settings and then matching the engravings to **PhotoGrav**'s Simulated Image by adjusting the effective spot size as a function of the previously-mentioned variables.

All simulation models contain some approximations and **PhotoGrav**'s model is no exception. Most of these approximations are very straightforward and require no explanation since they adhere very closely to reality. However, one approximation does require some explanation and that approximation occurs when the engraver dpi does not match the image dpi. For example, suppose that an image is digitized at 250 dpi but is to be engraved at 500 dpi. If **PhotoGrav**'s simulated image were to be produced at 500 dpi, then it would be four times larger than if it were produced at 250 dpi and would take approximately four times longer to produce. So, in order to save both disk space and execution time, **PhotoGrav** produces the simulated image at 250 dpi but modifies the "effective spot size and power" so that an engraving dpi of 500 dpi is approximated. To see this effect, start **PhotoGrav**, select an input image of 250 dpi (or 300 dpi), choose Black Laser Brass as the engraving material, and "interactive process" the image. Within the **Interactive Process** window, left-click the "Simulation" function box so its parameters are visible (see Fig. 3.2-7 in Sec. 3.2.2.2.5). Change the Power setting to 15% and make sure that the "Show Spot" check box is checked so that a representation of the effective spot is visible. Choose 250 (or 300) DPI from the list and note the appearance of the effective spot. Then choose 500 (or 600) DPI from the list and note that the spot has gotten much brighter and larger, especially in the cross scan (vertical) dimension. These differences in the effective spot size are indicators of the approximation that **PhotoGrav** uses when the engraver dpi does not match the image dpi.

As noted in Sec. 2.2, the Simulation Image might not always be a good representation of the actual engraving produced from the processed image due to factors that vary in an unknown way. However, if you take steps to minimize these variations and take the time to develop some skill in interpreting **PhotoGrav**'s simulated image relative to your particular materials and engraver, then the simulation can be a powerful tool in reliably creating excellent photographic engravings.
Appendix 6
PhotoGrav License Agreement

IMPORTANT
READ CAREFULLY BEFORE INSTALLING THE SOFTWARE. When you enter your name as required
during installation, you indicate your acceptance of the following PhotoGrav License Agreement.

This is a legal agreement between you (either an individual or an entity) and Schrock's Computer Works ("SCW"). Use
of this software constitutes acceptance of the terms of this agreement. If you do not agree to the terms of this agreement,
contact Schrock's Computer Works for other licensing options or promptly return the software and the accompanying items
(including written materials and binders or other containers) to SCW or its authorized distributor from which you received
the software for a full refund.

1. GRANT OF LICENSE

The enclosed SCW software program (the "Licensed Software") may be used only by the registered owner. You may
use one copy of the SCW software product identified above, which includes "online" or electronic documents (the
"SOFTWARE") on a single computer. The SOFTWARE is in "use" on a computer when it is loaded into temporary
memory (i.e. RAM) or installed into permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that
computer.

2. COPYRIGHT

The Licensed Software is owned by SCW and is protected by United States copyright laws and international treaty
provisions. Therefore, you must treat the Licensed Software like any other copyrighted material (e.g., a book or musical
recording), except that you may either (i) make one copy of the Licensed Software solely for backup or archival purposes,
provided you reproduce and include SCW's copyright and trademark notices contained on the original disk labels on such
backup copy, or (ii) transfer the Licensed Software to a single hard disk, provided you keep the original solely for backup
or archival purposes. You may not copy the written materials accompanying the Licensed Software.

3. OTHER RESTRICTIONS

a. You may not use, copy, or modify the files containing the licensed software, or any backup copy, in whole or in part, or
translate such files into any other file format or language, except as expressly provided for in this agreement. You may not
rent, lease or sublicense the Licensed Software, but you may transfer the Licensed Software and accompanying written
materials on a permanent basis, provided you retain no copies, the recipient agrees to the terms of this License Agreement,
immediately contacts SCW to inform SCW of such transfer and pays to SCW a transfer fee in an amount to be determined
by SCW and in effect at the time in question. Upon such transfer, your license under this License Agreement is
automatically terminated.

b. You may not reverse engineer, decompile or disassemble the Licensed Software for any purpose whatsoever.

4. TERM

Your license is effective upon payment for and the opening of the package containing the Licensed Software. You may
terminate it at any time by destroying the Licensed Software together with all copies. It will also terminate upon conditions
set forth elsewhere in this Agreement or if you fail to comply with any term or condition of this Agreement. You agree
upon such termination to destroy all copies of the Licensed Software in any form in your possession or under your control.

5. LIMITED WARRANTY

SCW warrants that for a period of ninety (90) days from the date of receipt, the Licensed Software will perform substantially in accordance with the accompanying written materials. THE FOREGOING IS THE SOLE AND EXCLUSIVE WARRANTY OFFERED BY SCW. SCW DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE LICENSED SOFTWARE AND ALL ACCOMPANYING MATERIALS.

6. CUSTOMER REMEDY

SCW's entire liability and your exclusive remedy shall be, at SCW's option, either (a) return of the price paid, or (b) repair or replacement of the Licensed Software that does not meet SCW's Limited Warranty and which is returned to SCW within the warranty period. The Limited Warranty is void if failure of the Licensed Software has resulted from accident, abuse or misapplication. Any replacement of Licensed Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

7. DISCLAIMER OF DAMAGES

You assume responsibility for, among other things, (i) the selection of the Licensed Software to achieve your intended results, (ii) the acquisition of other software (including any programming or operating system software) and/or equipment compatible with the Licensed Software, and (iii) the installation, use and results obtained from the Licensed Software. Further, inasmuch as the price paid for the license rights granted to you to use the Licensed Software may be substantially disproportionate to the value of products to be used in conjunction with, or produced by, the Licensed Software, and for the express purpose of limiting the liability against SCW to an extent which is reasonably proportionate to the commercial value of this transaction, you agree that, to the maximum extent permitted by law, SCW shall in no event be liable for any damages whatsoever (including without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the Licensed Software, whether direct, indirect, incidental, consequential, special or otherwise, REGARDLESS OF THE FORM OF ACTION, even if SCW has been advised of the possibility of such damages.

8. UPDATES & TECHNICAL SUPPORT

For a period of one year from the date of your receipt of the Licensed Software, SCW will make available to you Technical Support in the manner and under the guidelines set forth in the Licensed Software user documentation, which may be modified from time to time by SCW at its discretion without notice. SCW may, from time to time, revise or update the Licensed Software. In so doing, SCW incurs no obligation to furnish such revision or updates to you. Updates and further support terms are available to you on the same basis as SCW makes them available to its other licensees at then current prices.

9. GENERAL

a. This License is personal between you and SCW. It is not transferable and any attempt by you to rent, lease, sublicense, assign or transfer any of the rights, duties or obligations hereunder, except as provided in Section 3, above, is void. This Agreement and the conduct of the parties hereto shall be governed by the laws of the State of Indiana.

b. YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER ACKNOWLEDGE THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN YOU AND SCW WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN YOU AND SCW OR SCW'S AGENT(S) RELATING TO THE LICENSED SOFTWARE.
**Glossary**

**.BMP Image**

The Windows standard file format for imagery data although many other file formats are supported by many Windows programs. **PhotoGrav** requires that the Original (input) image be stored on disk as a .bmp file. Many image processing programs, e.g., CorelDraw, Adobe PhotoShop, etc., will convert other formats such as JPEG and TIFF to the .bmp format.

**Context-sensitive Help**

**PhotoGrav**'s context-sensitive help is available by left-clicking a small command button containing a blue "?" and located near the upper right of most windows. Clicking the button causes the cursor to change into a "?". Positioning the "?" cursor on an enabled control, about which one wants information, and then clicking causes a dialog box to appear which contains information about the control. Clicking the dialog box makes it disappear.

**dpi**

Dots per inch. A measure of the resolution of an image or of the device used to print or engrave the image. Often used interchangeably with pixels per inch.

**DPI Specification Window**

This window provides the capability to change the dpi (dots per inch) associated with the current input image. The window is automatically invoked if the input image has an invalid dpi. In this case, you must enter a new, valid dpi or PhotoGrav will not process the image. You can also invoke this window from the File menu of the Input Selection Window to change a valid dpi. You might want
to do this to match the dpi of your Laser Engraver or to change the size (in inches) of the input image (which would also change the size of the Engraved & Simulation images). PhotoGrav changes the dpi of the input image only for the duration of the PhotoGrav session. Thereafter, the input image dpi reverts to its original value (see Sec. 4.3).

**Engraved Image**

This is the processed image that PhotoGrav produces that should be sent to your laser engraver. This image is a binary image (black & white) in .bmp format.

**Engraving Results Window**

This window displays the results of PhotoGrav's processing functions in a manner that facilitates comparisons to the original input image. The input image, the engraved image, and the simulation image are all displayed, one at a time, within this window. The images can be successively and rapidly displayed by clicking a "Cycle Images" command button. Also, the images can be enlarged in a variety of ways to further enhance the comparison capabilities (see Sec. 3.3).

**Grayshade (or Grayscale) Image**

An image composed of pixels each of which consists of an 8-bit number which represents a shade of gray with zero representing black and 255 representing white. PhotoGrav requires only that the Original (input) image be an 8-bit image and will accept "indexed-color" 8-bit images but any Look Up Table (LUT) stored with the image is ignored in PhotoGrav's processing functions.

**Info Report Window**

This window displays all available information about the input image, engraving material, processing parameters, and the Laser Engraver parameters currently being modeled by PhotoGrav. The top section of the report (darker gray) presents information about the PhotoGrav version in use, the session duration, and the current date and time. The remainder of the report contains one to three sections depending on which window invoked Info Report and whether or not an input image was opened at that time. The three sections of the report contain information about the Input Image, the Process Parameters (including the engraving material, any Named Parameter Set that was in effect, and the Laser Engraver parameters) and the Process Results. The light gray window scrolls if
all the information cannot fit the display screen (see Sec. 4.4).

Input Selection Window

This window provides for: (1) Selection of an input image, (2) Selection of an engraving material, and (3) Initiation of interactive or auto processing functions. This window also provides access to the Preferences window (for selecting PhotoGrav options) and provides the capability to change, temporarily, the dpi (dots per inch) of an image (see Sec. 3.1)

Interactive Process Window

This window provides the capability for you to specify or adjust the parameters for all of PhotoGrav's processing functions and to view the results in near real time. The Original (input) image is displayed in the upper-left portion of the window and the processed image is displayed in the upper-right portion of the window (see Sec. 3.2)

Menu Bar

A panel, located just below the Title Bar of each of PhotoGrav's primary windows, which contains a set of dropdown menu titles specific to each window. Items on the dropdown menus usually have corresponding command buttons located in the ToolBar or elsewhere on the window.

Modify Material Window

Provides for the selection of an engraving material and the capability to modify its appearance (brightness, contrast, and color). When finished with selecting and modifying the engraving material, you must either Interactive Process or Auto Process the currently selected image or Exit the PhotoGrav program (see Sec. 4.2).

Named Parameter Set

Named Parameter Sets are small files stored on disk that completely specify the processing parameters, including the engraving material, that were used to
create engraved and simulation images.

**Negative-Polarity Engraving Materials**

Engraving materials for which a laser engraver will cause the material to become lighter in color or intensity than the original color or intensity of the material when the laser is on.

**Original Image**

The image, in 8-bit grayscale .bmp format, that is the input image to PhotoGrav. This image is the digitized photograph that you want to engrave.

**Pixel**

The smallest element of a digital image that can be assigned an independent color and/or intensity.

**Positive-Polarity Engraving Materials**

Engraving materials for which a laser engraver will cause the material to become darker in color or intensity than the original color or intensity of the material when the laser is on.

**Preferences Window**

This window provides for the selection and/or modification of your Laser Engraver and its specifications. It also provides for the setting or modification of other PhotoGrav options and operational parameters (see Sec. 4.1).
Primary Windows

A small number (four) of windows which PhotoGrav uses to functionally organize the major steps involved in preparing a digitized photograph for engraving. The four primary windows are the Input Selection window, the Interactive Process window, the Engraving Results window, and the Text/Resize window.

Print Window

This window lets you choose whether to print images at actual size OR at a size scaled to the size of your paper (see Sec. 4.5).

Simulation Image

This is a simulation, produced by PhotoGrav, of what the engraved image will look like when engraved on the selected engraving material. This image is a 24-bit, true color image in .bmp format. This image is useful for customer proofs and for reference BUT is NOT the image to be sent to the laser engraver.

Status Bar

Four panels arranged horizontally along the bottom of each of PhotoGrav's primary windows. In general, the panels contain the name and path of the input image, the engraving material and/or the engraver parameters, and the current date and time.

Support Windows

A small number of windows which PhotoGrav uses to provide a variety of functions to support the smooth flow of events within a PhotoGrav session. Generally, the support windows are invoked from one or more of PhotoGrav's primary windows.
Text/Resize Window

Provides the capability to resize and/or add text to the Engraved and Simulation images. Resizing can be used to "crop" or to enlarge the processed images. Any number of captions can be added to the processed images (see Sec. 3.4).

Title Bar

The bar that occurs at the top of each of PhotoGrav's windows. Generally, the title bar contains, from left to right, the PhotoGrav icon, the name of the specific window and the quantity of free disk space on the scratch disk that is used to store PhotoGrav's temporary files.

ToolBar

A gray panel positioned just below the Menu Bar of all of PhotoGrav's primary windows, except the Interactive Process window. The ToolBar contains command buttons appropriate to each window. It can be hidden, via an item on the View menu, which usually makes the image display area slightly larger. ToolBar command buttons usually have corresponding menu items available on the dropdown menus residing on the Menu Bar.